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funzioni del nuovo lettore mp3
Linee accattivanti. Intelligente. Affi dabile. Divertente.Il nuovo lettore 
mp3 è tutto questo e molto di più.La sua tecnologia all’avanguardia 
offre un suono ricco, immagini intense e giochi ricchi di azione.Sarete 
letteralmente conquistati dal vostro nuovo lettore MP3: sia mentre 
imparerete a utilizzarlo, sia quando sarete in grado di scaricare i vostri 
brani preferiti, di guardare i video, di giocare o di ascoltare la radio FM.Vi 
basterà provarlo una volta e poi non potrete più farne a meno.

MOLTIPLICARE LE FUNZIONI IN UN 
OGGETTO MULTIMEDIALE
Lo chiamiamo lettore MP3, ma è molto di 
più di questo. Vi permette di vedere delle 
immagini, del testo, dei video, di ascoltare la 
radio FM e di divertirvi con i videogiochi.

NAVIGARE CON UN SEMPLICE TOCCO 
DELLE DITA!
Toccare il touchpad per navigare nei menu.

DISPLAY LCD A COLORI
Il display LCD offre immagini e colori vividi.

FORMATI SUPPORTATI E 
COMPATIBILITÀ
Il nuovo lettore non si limita ai fi le MP3. 
Supporta infatti sia formati MP3 che formati 
WMA.

TEMPO DI RIPRODUZIONE PIÙ LUNGO E 
SCARICAMENTO PIÙ BREVE!
Con una batteria completamente carica è 
possibile riprodurre fi no a 30 ore di musica o 
4 ore di video. 
Grazie alla capacità del suo USB 2.0 il
lettore è molto più veloce dei modelli con
USB 1.1

SUONO RIVOLUZIONARIO
Il nuovo lettore mp3 è dotato del DNSe™
(Digital Natural Sound engine), l’esclusiva
tecnologia del suono Samsung creata per
offrire un suono più ricco e più profondo e
quindi un’esperienza di ascolto eccezionale.



informazioni sulla sicurezza
Signifi cato dei simboli utilizzati in questo manuale utente :

AVVERTENZA
Pericolo di morte o di lesioni personali gravi.

ATTENZIONE

Potenziale rischio di lesioni a persone o di danni al 
materiale.

ATTENZIONE

Precauzioni di sicurezza di base da seguire per ridurre il
rischio di incendio, esplosione, scossa elettrica o lesioni
personali durante l’utilizzo del lettore MP3:

NOTA
Suggerimenti o riferimenti utili relativi al funzionamento
del lettore.

Da NON fare.

NON smontare.

NON toccare.

Seguire scrupolosamente le indicazioni.

Scollegare la spina di alimentazione dalla presa a muro.

Contattare il centro di assistenza.

Queste icone di avvertimento sono state pensate allo scopo di evitare 
lesioni personali. Seguire quindi scrupolosamente le indicazioni. Dopo 
aver letto questa sezione, conservarla in un luogo sicuro per future 
consultazioni.



informazioni sulla sicurezza
Il presente manuale descrive come utilizzare in modo appropriato il
nuovo lettore mp3. Leggerlo attentamente per evitare di danneggiare il
lettore e di subire lesioni personali.
Prestare particolare attenzione ai seguenti messaggi d’avviso:

PER LA PROTEZIONE PERSONALE
Non smontare, riparare o modifi care questo prodotto da soli.

Non bagnare il prodotto e non farlo cadere in acqua. Se il prodotto si 
bagna, non accenderlo perché si rischia di subire una scossa elettrica. 
Contattare invece il centro di assistenza Samsung più vicino.

Non utilizzare il prodotto in presenza di lampi o tuoni. Rischio di 
malfunzionamento o di scossa elettrica.

Non utilizzare gli auricolari mentre si è alla guida di una bicicletta, di 
un’automobile o di un motociclo. 
In caso contrario si potrebbe incorrere in un grave incidente e, inoltre, in alcuni stati 
è proibito per legge.
L’utilizzo degli auricolari mentre si cammina o si fa jogging per strada, in particolare 
in prossimità dei passaggi pedonali, può causare gravi incidenti.

Per motivi di sicurezza personale, assicurarsi che il cavo delle cuffi e non 
si impigli nelle braccia o negli oggetti circostanti mentre si fa attività fi sica 
o si sta camminando.

Non collocare il prodotto in ambienti umidi, polverosi o fuligginosi perché 
in questi casi esiste rischio di incendio o di scossa elettrica.

ATTENZIONE

AVVERTENZA

ATTENZIONE



PER LA PROTEZIONE PERSONALE
L’uso di auricolari per un tempo prolungato può provocare seri danni all’udito.
L’esposizione prolungata a un’intensità del suono maggiore di 85 db può causare 
danni all’udito. Maggiore è l’intensità del suono, maggiore è la gravità dei danni 
all’udito (una conversazione normale ha un’intensità pari a 50 - 60 db e i rumori per 
strada hanno un’intensità pari a circa 80 db). Si consiglia di impostare il volume su 
un valore medio (solitamente il livello medio è inferiore ai 2/3 del massimo).
Se si avverte un fi schio alle orecchie mentre si utilizzano gli auricolari, 
abbassare il volume o rimuovere le cuffi e.

PER LA PROTEZIONE DEL LETTORE MP3
Non lasciare il lettore in ambienti con temperatura superiore a 95 °F 
(35 °C), come ad esempio una sauna o un’auto parcheggiata.
Non far cadere il lettore ed evitare urti eccessivi.
Non collocare oggetti pesanti sul lettore.
Evitare l’ingresso di particelle estranee o di polvere all’interno del 
prodotto.
Non collocare il prodotto vicino a oggetti magnetici.
Assicurarsi di creare una copia di backup dei dati importanti. Samsung non è 
responsabile per la perdita di dati.
Utilizzare esclusivamente accessori forniti o approvati da Samsung.
Non spruzzare acqua sul prodotto. Non pulire mai il prodotto con sostanze 
chimiche come benzene o diluenti, in quanto potrebbero causare incendi, 
scosse elettriche oppure danneggiare la superfi cie del prodotto.
La mancata osservanza delle istruzioni fornite in questo manuale 
comporta il rischio di infortuni o danni al lettore.
Se si sceglie di stampare il manuale utente, si raccomanda di optare per 
una stampa a colori e di selezionare “Adatta alla pagina” tra le opzioni di 
stampa per ottenere una migliore visualizzazione.
“Questo apparecchio è fabbricato in conformità al D. M. 28. 08. 95 n. 
°548 ed in particolare a quanto specifi cato nell’art.2, comma 1”

ATTENZIONE

NOTA

AVVERTENZA

ATTENZIONE
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elementi di base
ACCESSORI FORNITI
Il nuovo lettore mp3 viene fornito con i seguenti accessori. Se vi mancano alcuni di 
questi elementi, contattate il centro assistenza clienti Samsung.

Lettore Cuffi e

Cavo USB CD di installazione

Gli accessori contenuti nella scatola possono essere leggermente diversi da 
quelli presentati qui.
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IL LETTORE MP3

Schermo

Tasto Hold e di accensione

Farlo scorrere verso il basso e tenerlo 
premuto per accendere/spegnere 
l’apparecchio.
Farlo scorrere verso l’alto per bloccare le 
funzioni dei tasti.

Foro di reset
Se si verifi ca un malfunzionamento del 
lettore, premere il foro di reset con un 
oggetto appuntito per reinizializzare il 
sistema.
Microfono
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IL LETTORE MP3 (Continua)
I tasti indicati in basso sono “tasti a sfi oramento”.

Tasto Indietro
Toccare questo tasto per passare alla 

schermata precedente. Tenerlo brevemente 
premuto per spostarsi alla schermata del 

menu principale.

Tasto di aumento volume
Toccare questo tasto per aumentare il volume o 

per spostarsi su una voce/un menu superiore.

Tasto riproduzione/pausa, selezione
Toccare questo tasto per selezionare il modo 

riproduzione/pausa e confermare e spostarsi alla 
schermata successiva

Tasto di scorrimento fi le a sinistra
Toccare questo tasto per spostarsi sulla 

traccia/sul menu precedente o per riprodurre 
la traccia corrente dall’inizio. Premerlo e 
tenerlo brevemente premuto per cercare 

rapidamente le tracce.

Tasto di riduzione volume
Toccare questo tasto per abbassare il volume 

o spostarsi sulla voce/sul menu successivo.
Tasto di scorrimento fi le a destra
Toccare questo tasto per spostarsi sulla 

traccia/sul menu successivo. Premerlo e tenerlo 
brevemente premuto per cercare rapidamente le 

tracce.

Tasto menu
Toccare questo tasto per visualizzare il menu.
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IL LETTORE MP3 (Continua)

Cuffi e
L’auricolare sinistro reca il contrassegno 

“L” (left) e quello destro il contrassegno “R” 
(right). Scollegando gli auricolari durante la 
riproduzione della musica, la riproduzione 

viene messa in pausa.

Jack connessione cuffi e

Porta di collegamento USB

Foro per cordicella da 
appendere al collo
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Music

 Rising Sun
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SCHERMI DI VISUALIZZAZIONE
Musica

1 Indicatore menu principale

2 Indicatore di blocco

3 Stato della batteria

4
Indicatore della traccia corrente in 
riproduzione/ numero totale di tracce

5 Indicatore di velocità di riproduzione

6 Ora corrente

7 Tempo di riproduzione totale

8
Indicatore di riproduzione/pausa/
ricerca

9 Indicatore di modo musica

10 Indicatore di modo riproduzione

11 Indicatore di modo DNSe

12 Schermata di riproduzione musicale

13 Titolo Musica

14 Barra di stato di riproduzione

15 Tempo di riproduzione corrente

Le immagini delle schermate sono fornite esclusivamente a scopo di riferimento. Il 
loro aspetto puo’ variare.
Tutte le informazioni diverse da quelle sulla schermata di riproduzione musicale 
scompaiono dopo poco tempo.Toccare un qualsiasi tasto per visualizzarle di nuovo.

NOTA
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SCHERMI DI VISUALIZZAZIONE (Continua)
Video

1 Indicatore di blocco

2 Stato della batteria

3 Ora corrente

4 Tempo di riproduzione totale

5
Indicatore di riproduzione/
pausa/ricerca

6 Indicatore di modo video

7 Nome del fi le

8 Barra di stato di riproduzione

9 Tempo di riproduzione corrente
Immagini

1 Indicatore di blocco

2 Stato della batteria

3
Indicatore del fi le corrente / 
numero totale di fi le

4 Ora corrente

5 Stato di riproduzione musicale

6 Indicatore di modo immagine

7 Indicatore menu principale

8 Nome del fi le

Video Track 1

5

6

7

8

9

1

2

3

4

[visualizzazione anteprima]
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SCHERMI DI VISUALIZZAZIONE (Continua)
Radio FM

1 Ora corrente

2 Stato della batteria

3
Indicatore Blocco/Allarme/
Sleep timer

4 Indicatore di modo radio

5
Indicatore manuale/
preimpostato

6
Indicatore della frequenza 
attuale(MHz)

7
Indicatore della frequenza sulla 
scala

8 Indicatore RDS

Che cos’è l’RDS?
RDS (Radio Data System) consente di ricevere e di visualizzare i messaggi, 
come ad es. le informazioni sulla trasmissione radio. Le informazioni del 
programma, come ad es. notiziari, sport o musica o le informazioni della stazione di 
trasmissione, vengono visualizzate sullo schermo.
Se l’intensità del segnale FM è debole, le informazioni sull’RDS potrebbero non 
essere visualizzate.

1

Manual

3

4

6

7

2

5

News
 Today Headline

8

NOTA
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UTILIZZO DEL TASTO A SFIORAMENTO
Toccare il tasto a sfi oramento con la punta del dito.

Per evitare di danneggiare il tasto a sfi oramento, utilizzare solo le dita per sfi orarlo.
Non premere il tasto a sfi oramento con le dita sporche.
Non toccare il tasto a sfi oramento con i guanti.
Il tasto a sfi oramento può danneggiarsi se lo si tocca con le unghie o altri oggetti 
come ad esempio penne a sfera.

NOTA



18 _ elementi di base

CARICAMENTO DELLA BATTERIA
Se si utilizza il lettore per la prima volta, oppure se il lettore non è stato utilizzato 
per lungo tempo, è necessario ricaricare completamente la batteria.
La batteria del lettore MP3 impiega circa 3 ore per caricarsi completamente, 
anche se il tempo di carica totale varia a seconda del PC. 

1. Collegare l’estremità più larga del cavo USB alla porta di connessione USB 
sulla base del lettore.

2. Collegare il cavo USB alla porta USB ( ) del PC.

2

Schermo di  visualizzazione
<USB connected> 
(USB collegato)

< > - Batteria in carica

< > - Batteria completament
carica

1
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MANUTENZIONE DELLA BATTERIA
Per far durare il più a lungo possibile la batteria è suffi ciente seguire queste 
semplici indicazioni di manutenzione e di conservazione.
• Ricaricare la batteria a una temperatura compresa tra 5 °C e 35 °C.
• Non sovraccaricare (più di 12 ore).

Il caricamento o scaricamento eccessivo può ridurre la vita utile della batteria. 
• La durata della batteria tende a diminuire gradualmente nel tempo.

Se si carica il lettore quando è collegato ad un computer portatile, assicurarsi che 
anche la batteria del portatile sia completamente carica e che il portatile sia inserito 
nella presa.
La batteria ricaricabile installata in questo prodotto non è sostituibile dall’utente. Per 
informazioni sulla sostituzione, contattare il proprio fornitore di servizi.

ACCENSIONE/SPEGNIMENTO
Accensione del prodotto
Far scorrere il tasto [ ] verso il basso e tenerlo 
premuto.

Il prodotto si accende.

Spegnimento del prodotto
Far scorrere nuovamente il tasto [ ] verso il 
basso e tenerlo premuto.

Il prodotto si spegne.

Se non si preme nessun tasto per un dato periodo di tempo quando l’apparecchio è 
in pausa, questo si spegne automaticamente. L’impostazione predefi nita per <Auto
Power Off> (Spegnimento automatico disattivato) è 1 minuto, ma questo valore può 
essere modifi cato. Per ulteriori informazioni, vedere a pagina 29.

NOTA

ATTENZIONE

NOTA
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RIPRODUZIONE DEI FILE MUSICALI
Caricare i fi le musicali sul lettore MP3 mediante EmoDio.
1. Tenere premuto il tasto [ ] per passare alla schermata 

del menu principale.
2. Toccare il tasto [Su, Giù, Sinistra, Destra] per selezionare 

<Music> (Musica), quindi toccare il tasto di [selezione].
3. Utilizzare il tasto [Su, Giù] e il tasto di [selezione] per

selezionare il fi le musicale desiderato.
4. Toccare il tasto di [selezione] per riprodurre il fi le musicale 

selezionato.
Il fi le verrà riprodotto.

Toccare [ ] per passare alla schermata precedente. 
Tenere premuto il tasto [ ] per passare alla schermata del menu principale.

CONTROLLO DEL VOLUME
Toccare il tasto [Su, Giù].

Verrà visualizzata un’icona di regolazione del volume.
Il range del volume è impostato tra 0 a 30.
Toccare il tasto [Su] per aumentare il volume e il tasto [Giù] per 
abbassarlo.

Music

Rising Sun

02:13 04:28

Music

Rising Sun

02:13 04:28

NOTA
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DISABILITAZIONE DEI TASTI
La funzione Hold (Sospendi) disabilita tutti gli altri tasti del lettore MP3, per cui 
se se ne tocca uno involontariamente, la musica non si interrompe.
1. Far scorrere il tasto [ ] verso l’alto per attivare 

la funzione di blocco.
2. Far scorrere il tasto [ ] verso il basso per 

disattivare la funzione di blocco.

OPERAZIONE DI SFOGLIA MEDIANTE 
“FILE BROWSER (RICERCA FILE)”
La funzione “File Browser” (Ricerca File) consente di trovare con facilità i fi le.
1. Tenere premuto il tasto [ ] per passare alla schermata 

del menu principale.
2. Toccare il tasto [Su, Giù, Sinistra, Destra] per selezionare 

<File Browser> (Ricerca File), quindi toccare il tasto di 
[selezione].

Viene visualizzata la lista di cartelle <File Browser> (Ricerca 
File) contenenti Music (musica), Playlists (playlist), Video (video), 
Pictures (immagini), Datacasts (datacast), Texts (testi), Games 
(giochi), Recorded Files (fi le registrati) e My Pack (dati personali).

3. Toccare il tasto [Su, Giù] per selezionare la cartella desiderata.
4. Toccare il tasto di [selezione] per visualizzare l’elenco dei fi le contenuti nella 

cartella selezionata.
Toccare [ ] per passare alla schermata precedente.

5. Toccare il tasto [Su, Giù] per selezionare il fi le desiderato.
6. Toccare il tasto di [selezione].

Verrà avviata la riproduzione del fi le.

Music

Rising Sun

02:13 04:28
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ELIMINAZIONE DEI FILE IN “FILE BROWSER 
(RICERCA FILE)”
1. Tenere premuto il tasto [ ] per passare alla schermata 

del menu principale.
2. Toccare il tasto [Su, Giù, Sinistra, Destra] per selezionare 

<File Browser> (Ricerca File), quindi toccare il tasto di 
[selezione].

Viene visualizzata la lista di cartelle <File Browser> 
(Ricerca File).

3. Toccare il tasto [Su, Giù] per selezionare la cartella 
desiderata, quindi toccare il tasto di [selezione].

4. Toccare il tasto [Su, Giù] per selezionare il fi le da eliminare, quindi toccare
[ ].

5. Toccare il tasto [Su, Giù] per selezionare <Delete> (Elimina), quindi toccare 
il tasto di [selezione].

Viene visualizzata la fi nestra di conferma.

6.  Toccare il tasto [Sinistra, Destra] per selezionare <Yes> (Sì), quindi toccare 
il tasto di [selezione].

Il fi le viene eliminato.

Una volta che i fi le sono eliminati, non possono essere recuperati.

Il fi le che si sta ascoltando non viene eliminato.
La cartella <My Pack> (Personale) sotto <File Browser> (Ricerca File) contiene 
i fi le DNSe trasferiti con <EmoDio>.Per ulteriori informazioni su DNSe vedere 
<EmoDio>.

ATTENZIONE

File Browser

Music
Playlists
Video
Pictures
Datacasts
Texts
Games
Recorded Files
My Pack

NOTA
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MODIFICA DELLE IMPOSTAZIONI E DELLE PREFERENZE
Il lettore MP3 viene fornito con impostazioni e preferenze confi gurate in fabbrica, ma 
è possibile cambiare questi valori predefi niti per personalizzare il lettore.

Toccare [ ] per passare alla schermata precedente. 
Tenere premuto il tasto [ ] per passare alla schermata del menu principale.

Impostazione dello stile dei menu
È possibile modifi care l’aspetto e il font del menu e eliminare l’immagine 
sullo sfondo del menu principale.
1. Tenere premuto il tasto [ ] per passare alla 

schermata del menu principale.
2. Toccare il tasto [Su, Giù, Sinistra, Destra] per 

selezionare <Settings> (Impostazioni), quindi 
toccare il tasto di [selezione].

Si apre il menu <Settings> (Impostazioni).
3. Toccare il tasto [Su, Giù] per selezionare <Menu

Style> (Stile menu), quindi toccare il tasto di 
[selezione].

Si apre il menu  <Menu Style> (Stile menu).
4. Utilizzare i tasti [Su, Giù] e di [selezione] per impostare le funzioni.

Toccare il tasto di [selezione] per passare alla voce successiva/selezionare 
il menu. 
Toccare il tasto [Su, Giù] per spostarsi in alto o in basso nel menu corrente.

Opzioni di impostazione Stile menu
Menu Design (Design menu): È possibile cambiare lo stile della schermata del 
menu principale. Scegliere <Matrix> (Matrice) o <My Skin>(Mia pelle). 
Font : È possibile cambiare il tipo di font della lingua del menu. Selezionare uno 
dei tre tipi di font. In alcune lingue del menu, <Font> viene disabilitato.
Reset My Skin (Ripristina Mia pelle): Ripristina l’immagine in background del 
touch screen alla sua immagine predefi nita. 

Settings

Menu Style
Sound
Display
Language
Date&Time 
System

NOTA
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MODIFICA DELLE IMPOSTAZIONI E DELLE 
PREFERENZE (Continua)

Impostazioni audio
È possibile impostare l’equalizzatore principale, il suono del bip e il 
limite del volume.
1. Tenere premuto il tasto [ ] per passare alla 

schermata del menu principale.
2. Toccare il tasto [Su, Giù, Sinistra, Destra] per 

selezionare <Settings> (Impostazioni), quindi 
toccare il tasto di [selezione].

Si apre il menu <Settings> (Impostazioni).

3. Toccare il tasto [Su, Giù] per selezionare <Sound>
(Suono), quindi toccare il tasto di [selezione].

Si apre il menu <Sound> (Suono).
4. Utilizzare i tasti [Su, Giù] e di [selezione] per impostare le funzioni.

Opzioni di impostazione dell’effetto sonoro 
Master EQ (EQ principale): È possibile ottimizzare le impostazioni audio. 
Toccare il tasto [Sinistra, Destra] per selezionare la frequenza da impostare. 
Toccare il tasto [Su, Giù] per regolare il livello della frequenza selezionata, 
quindi toccare il tasto di [selezione].
Beep Sound (Suono bip): Attiva o disattiva il suono bip per le operazioni su 
touch screen. Selezionare tra <Off> e <On>.
Volume Limit (Limite Volume): Impostando un limite di volume massimo 
quando si utilizzano le cuffi e si può evitare di provocare danni all’udito. 
<On> Impostare su 15 il livello massimo del volume.
Il livello massimo del volume con limite impostato su <Off> è 30.
Anche se è stato selezionato <Off>, il volume viene ripristinato a 15 per evitare 
danni all’udito quando si riaccende il lettore.

Settings

Menu Style
Sound
Display
Language
Date&Time 
System
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MODIFICA DELLE IMPOSTAZIONI E DELLE 
PREFERENZE (Continua)

Impostazioni di visualizzazione
Modifi care il tempo di spegnimento e la luminosità del display.
1. Tenere premuto il tasto [ ] per passare alla 

schermata del menu principale.
2. Toccare il tasto [Su, Giù, Sinistra, Destra] per 

selezionare <Settings> (Impostazioni), quindi 
toccare il tasto di [selezione].

Si apre il menu <Settings> (Impostazioni).

3. Toccare il tasto [Su, Giù] per selezionare
<Display> (Display), quindi toccare il tasto di 
[selezione].

Si apre il menu <Display>.
4. Utilizzare i tasti [Su, Giù] e di [selezione] per impostare le funzioni.

Opzioni di impostazione della visualizzazione
Display Off (Schermo Off): Se non si preme alcun tasto per il periodo di tempo 
selezionato, lo schermo si spegnerà automaticamente. Scegliere tra <15sec>, 
<30sec>, <1min>, <3min>, <5min> e <Always On> (Sempre acceso). Premere 
un tasto qualsiasi per riattivare lo schermo. 
Brightness (Luminosità): È possibile regolare la luminosità della schermata.
Selezionare un livello da <0-10>, dove il valore 10 indica la massima luminosità.

Settings

Menu Style
Sound
Display
Language
Date&Time 
System
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MODIFICA DELLE IMPOSTAZIONI E DELLE 
PREFERENZE (Continua)

Impostazioni della lingua
I menu del lettore mp3 possono essere impostati in modo da apparire in 
una delle lingue offerte. La lingua può essere cambiata facilmente.

1. Tenere premuto il tasto [ ] per passare alla 
schermata del menu principale.

2. Toccare il tasto [Su, Giù, Sinistra, Destra] per 
selezionare <Settings> (Impostazioni), quindi 
toccare il tasto di [selezione].

Si apre il menu <Settings> (Impostazioni).

3. Toccare il tasto [Su, Giù] per selezionare 
<Language> (Lingua), quindi toccare il tasto di 
[selezione].

Viene visualizzato l’elenco <Language> (Lingua).
<English>, <한국어>, <Français>, <Deutsch>, <Italiano>, <日本語>,
< >, < >, <Español>, < >, <Magyar>, <Nederlands>, 
<Polski>, <Português>, <Svenska>, < >, < eština>, < >,
<Türkçe>, <Norsk>, <Dansk>, <Suomi>, <Español> (Sudamérica)>, 
<Português> (Brasil), <Indonesia>, <Ti ng Vi t>, <Bulgarian>, <Român >,
< >, <Slovenš ina>, <Slovenský>.

4. Toccare il tasto [Su, Giù] per selezionare la lingua desiderata, quindi 
toccare il tasto di [selezione].

Le lingue supportate possono essere modifi cate o aggiunte.

Settings

Menu Style
Sound
Display
Language
Date&Time 
System

NOTA
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MODIFICA DELLE IMPOSTAZIONI E DELLE 
PREFERENZE (Continua)

Impostazioni della data e dell’ora
Impostare la data e l’ora correnti.

1. Tenere premuto il tasto [ ] per passare alla 
schermata del menu principale.

2. Toccare il tasto [Su, Giù, Sinistra, Destra] per 
selezionare <Settings> (Impostazioni), quindi 
toccare il tasto di [selezione].

Si apre il menu <Settings> (Impostazioni).

3. Toccare il tasto [Su, Giù] per selezionare 
<Date&Time> (Data&Ora), quindi toccare il tasto di 
[selezione].

Viene visualizzata la schermata di impostazione dell’ora.

4. Toccare il tasto [Sinistra, Destra] per spostarsi su <YEAR (ANNO), 
MONTH (MESE), DATE (DATA), HOUR (ORA), MIN, AM/PM>, quindi 
toccare il tasto [Su, Giù] per impostare ogni voce.

5. Toccare il tasto di [selezione].
Viene visualizzata la fi nestra di conferma del salvataggio.

6. Toccare il tasto [Sinistra, Destra] per selezionare <Yes> (Sì), quindi 
toccare il tasto di [selezione].

La data e l’ora vengono salvate. 

Settings

Menu Style
Sound
Display
Language
Date&Time 
System
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MODIFICA DELLE IMPOSTAZIONI E DELLE 
PREFERENZE (Continua)

Impostazioni di sistema
Scegliere l’impostazione predefi nita di disattivazione, di modo di avvio e 
di spegnimento automatico più adatta.

1. Tenere premuto il tasto [ ] per passare alla 
schermata del menu principale.

2. Toccare il tasto [Su, Giù, Sinistra, Destra] per 
selezionare <Settings> (Impostazioni), quindi 
toccare il tasto di [selezione].

Si apre il menu <Settings> (Impostazioni).

3. Toccare il tasto [Su, Giù] per selezionare 
<System> (Sistema), quindi toccare il tasto di 
[selezione].

Si apre il menu <System> (Sistema).

4. Utilizzare i tasti [Su, Giù] e di [selezione] per impostare le funzioni.

Settings

Menu Style
Sound
Display
Language
Date&Time 
System
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MODIFICA DELLE IMPOSTAZIONI E DELLE 
PREFERENZE (Continua)

Opzioni di impostazione di sistema
My Profi le (Profi lo): Consente di impostare il nome e la data di nascita.Vedere pagine 
30~31.
Sleep (Sospendi): Disattiva automaticamente l’alimentazione una volta trascorso il periodo 
di tempo specifi cato. Le opzioni disponibili sono <Off>, <15min>, <30min>, <60min>, 
<90min> o <120min>.
Start Mode (Avvia modo): Consente di impostare la schermata iniziale visualizzata quando 
si accende il lettore.Scegliere <Main Menu> (Menu principale) o <Last State> (Ultimo 
stato).Selezionare <Main Menu> (Menu principale) per visualizzare, all’avvio del sistema, 
la schermata del menu principale o <Last State> (Ultimo stato) per visualizzare l’ultima 
schermata utilizzata.
Auto Power Off (Spegnimento automatico disattivato): Disattiva automaticamente 
l’alimentazione quando l’apparecchio è in pausa e non si esegue alcuna operazione per il 
periodo di tempo specifi cato. Scegliere tra <15sec>, <30sec>, <1min>, <3min>, <5min> o 
<Always On> (Sempre acceso).
Default set (Imp. predefi n.): Vengono ripristinati i valori predefi niti di tutte le impostazioni. 
Le opzioni disponibili sono <Yes> (SÌ) o <No>. <Yes> (SÌ) ripristina tutte le impostazioni di 
fabbrica. <No> annulla l’operazione.
Format (Formattazione): Formatta la memoria interna. Le opzioni disponibili sono <Yes> 
(SÌ) o <No>. Selezionando <Yes> (SÌ) si formatta la memoria interna e si eliminano tutti i fi le 
sul lettore. Selezionando <No> la memoria interna non viene formattata. Controllare qual è 
l’opzione impostata prima di eseguire la formattazione.
About (Info su): Toccare il tasto [Sinistra, Destra] per controllare la versione del fi rmware, 
la capacità di memoria e il numero di fi le.<Firmware Ve> (Versione fi rmware) visualizza la 
versione attuale del fi rmware.<Memory> (Memoria) - <Used> (Usata) indica la memoria 
utilizzata, <Available> (Disponibile) la capacità rimanente e <Total> (Totale) la capacità 
totale della memoria.<Files> (File) - Consente di controllare il numero di fi le musicali, video, 
immagini, testi e il numero totale di fi le.
Demo Mode (Modo Demo): Se è impostato su <On>, il lettore continua a riprodurre il video 
nella relativa cartella.Per tornare alla schermata precedente, toccare il tasto a sfi oramento.

Informazioni sulla memoria incorporata
1GB=1,000,000,000byte: La capacità di formattazione reale può essere 
inferiore poiché il fi rmware interno utilizza una parte di memoria.

NOTA
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MODIFICA DELLE IMPOSTAZIONI E DELLE 
PREFERENZE (Continua)

Impostazione del nome

1. Toccare il tasto [Su, Giù] per selezionare <My 
Profi le> (Profi lo), quindi toccare il tasto di 
[selezione].

2. Toccare il tasto [Su, Giù] per selezionare <My 
Name> (Nome), quindi toccare il tasto di 
[selezione].

Viene visualizzata la fi nestra di modifi ca del nome.

3. Utilizzare i tasti [Su, Giù, Sinistra, Destra] e di 
[selezione] per modifi care il nome del dispositivo.

[  ] : Il modo di inserimento passa dal maiuscolo al minuscolo, ai numeri.
[  ] : Consente di eliminare i caratteri uno alla volta.
[  ] : Consente di inserire ‘–’.
[  ] : Confermare la modifi ca.
Una volta impostato il nome, questo verrà visualizzato ogni volta che si 
accende il lettore.

Rename My ..

_
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MODIFICA DELLE IMPOSTAZIONI E DELLE 
PREFERENZE (Continua)

Impostazione della data di nascita

Prima di iniziare! - Prima di tutto, è indispensabile impostare l’orologio 
sull’ora esatta. Vedere pagina 27.

1. Toccare il tasto [Su, Giù] per selezionare <My 
Profi le> (Profi lo), quindi toccare il tasto di 
[selezione].

2. Toccare il tasto [Su, Giù] per selezionare <My
Birthday> (Compleanno), quindi toccare il tasto di 
[selezione].

Viene visualizzata la fi nestra di modifi ca della data di 
nascita.

3. Toccare il tasto [Sinistra, Destra] per spostarsi su <YEAR (ANNO), 
MONTH (MESE), DATE (DATA)>, quindi toccare il tasto [Su, Giù] 
per impostare ogni voce.

4. Toccare il tasto di [selezione].
Una volta impostata la data di nascita, questa vi verrà ricordata ogni volta 
che si accende il lettore.

Edit My Birth..
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RIPRISTINO DEL SISTEMA
Se il lettore MP3 non si accende, non riproduce i fi le musicali o non viene 
riconosciuto dal computer al momento della connessione, può essere 
necessario eseguire il ripristino del sistema.

Non inserire un oggetto appuntito nel foro del microfono; potrebbe danneggiare il 
prodotto.ATTENZIONE

Premere il Foro di reset sulla parte inferiore 
del prodotto con un oggetto appuntito, 
come ad esempio un fermaglio.

Il sistema verrà inizializzato.
La funzione di reset non elimina le informazioni 
e i dati registrati nella memoria incorporata.



EmoDio _ 33

EmoDio
EmoDio è un’applicazione software del lettore MP3 in grado di fornire 
diversi servizi legati al contenuto e supporti per dispositivi.

REQUISITI DEL PC
Per installare ed eseguire EmoDio, il sistema del PC deve rispondere ai 
seguenti requisiti minimi:

• Pentium 500MHz o superiore
• USB Port 2.0
• Windows XP Service Pack 2 o 

versione successiva
• DirectX 9.0 o superiorer
• 100MB di spazio libero sul disco 
fi sso

• Windows Media Player 10.0 o 
versione successiva

• Unità CD Rom (2X o superiore)
• Risoluzione 1024 X 768 o superiore
• Internet Explorer 6.0 o versione 

successiva
• 512 MB RAM o superiore

Non scollegare la spina USB durante il trasferimento dei fi le. Lo scollegamento 
durante l’operazione di trasferimento dei fi le può danneggiare il lettore o il PC.
Si consiglia di collegare il lettore direttamente al PC anziché attraverso un hub USB 
per evitare che la connessione sia instabile.

Tutte le funzioni sono disabilitate durante la connessione.

Utilizzare FAT 32 per il fi le system quando si formatta il lettore sul PC.In Windows 
Vista, fare clic su Ripristina impostazioni predefi nite periferica ed eseguire la 
formattazione.

ATTENZIONE

NOTA
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INSTALLAZIONE DI EMODIO
Eseguire innanzitutto il programma di installazione di <EmoDio> nell’account 
amministratore del PC. Senza questa operazione, <EmoDio> non può essere 
installato. Per trovare l’account amministratore, fare riferimento al manuale utente 
del PC.

1. Inserire il CD di installazione fornito con il 
lettore nell’unità CD-Rom del computer.

2. Fare clic su <Install now> (Installa adesso).
Seguire le istruzioni per avviare l’installazione.
Viene avviata l’installazione di <EmoDio>, al 
termine dell’installazione, sul desktop viene 
creata l’icona .

Prestare la massima attenzione nel caricare/rimuovere il CD di installazione se si 
utilizza un CD-ROM di tipo verticale.

La tecnologia di riconoscimento audio e i dati correlati sono forniti da Gracenote e 
Gracenote CDDB® Music Recognition ServiceSM.

CDDB è un marchio registrato di Gracenote. Il logo Gracenote, il logo Gracenote 
CDDB e il logo “Powered by Gracenote CDDB” sono marchi di Gracenote. Music 
Recognition Service e MRS sono marchi di servizio di Gracenote.

ATTENZIONE

ATTENZIONE

NOTA
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UTILIZZO DI EMODIO
EmoDio è un’applicazione software di facile utilizzo per organizzare i fi le 
sul PC. Quando i fi le sono già ordinati e organizzati in EmoDio, li si può 
trasferire rapidamente sull’mp3 senza dover cercare quelli desiderati in 
tutto l’hard disk.

L’utilizzo di “EmoDio” è il modo più semplice per trasferire i fi le dal 
PC al lettore MP3.

“EmoDio” permette di creare una propria raccolta o album di fi le 
audio.

Consente di trasferire sul lettore le informazioni di un blog e i fi le 
registrati su RSS a scopo di intrattenimento.

Si tratta di un servizio di community online degli utenti di EmoDio.
com.Consente di caricare/scaricare in modo semplice i contenuti 
generati utilizzando EmoDio e di condividere le proprie esperienze 
con gli altri utenti della community.

Per ulteriori informazioni su <EmoDio>, fare clic su <MENU> <Help> (Guida) 
<Help> (Guida) nella parte superiore della schermata del programma <EmoDio>.NOTA
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ascolto della musica
Prima di iniziare! - Collegare le cuffi e, quindi accendere il lettore e controllare lo 
stato della batteria.
Toccare [ ] per passare alla schermata precedente. 
Tenere premuto il tasto [ ] per passare alla schermata del menu principale.

RIPRODUZIONE PER CATEGORIA

1. Tenere premuto il tasto [ ] per passare alla schermata del menu principale.
2. Toccare il tasto [Su, Giù, Sinistra, Destra] per selezionare <Music>

(Musica), quindi toccare il tasto di [selezione].
Viene visualizzato l’elenco <Music> (Musica).

3. Toccare il tasto [Su, Giù] per selezionare l’elenco desiderato, quindi toccare 
il tasto di [selezione].

Viene visualizzato il fi le musicale.

4. Toccare il tasto [Su, Giù] per selezionare il fi le da riprodurre, quindi toccare il
tasto di [selezione].

Il fi le verrà riprodotto.

Music

Now Playing
Artists
Albums
Songs
Genres
Playlists
Recorded Files
Music Browser

Music

Rising Sun

02:13 04:28

NOTA
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RIPRODUZIONE PER CATEGORIA (Continua)

Elenco dei fi le musicali
Le informazioni sul fi le, inclusi il nome dell’artista, il nome dell’album, il titolo e il genere del 
brano vengono visualizzate secondo le informazioni del tag ID3 sul fi le musicale adatto. 
I fi le privi di etichetta ID3 (informazioni sul brano) vengono contrassegnati dall’indicatore 
[Unknown] (sconosciuto).

Now Playing (In Esecuzione): Riproduce un fi le recentemente riprodotto o passa al 
display di riproduzione del fi le corrente.
Artists (Artista): Riproduzione per artista.
Albums (Album): Riproduzione per album. Toccare [ ] per selezionare un <List 
Type)> (Tipo elenco. Selezionare <Album Art>(Copertina album) per visualizzare 
contemporaneamente sia l’immagine sulla copertina dell’album che il titolo dell’album o 
<List> (Elenco) per visualizzare solo il titolo dell’album.
Songs (Canzoni): Riproduzione in ordine numerico o alfabetico.
Genres (Genere): Riproduzione per genere. 
Playlists (Playlist): Riproduzione per sequenza brani.
Recorded Files (File Registrati): Mostra tutti i fi le registrati.
Music Browser (Browser musicale): Mostra tutti i fi le musicali salvati nella cartella 
Musica.

I formati compatibili con il lettore sono MP3 e WMA.
Se si modifi ca l’estensione di un fi le MP1 o MP2 in MP3, il fi le potrebbe non essere 
riproducibile.
Scollegando le cuffi e durante la riproduzione della musica, la riproduzione viene 
messa in pausa.
Che cos’è un’etichetta ID3?
Sono informazioni allegate ai fi le MP3 e relative al brano musicale, ad esempio 
titolo, artista, album, genere, oltre a un campo per i commenti.

NOTA
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MESSA IN PAUSA
1. Toccare il tasto di [selezione] durante la riproduzione di un brano.

La riproduzione verrà interrotta.

2. Toccare di nuovo il tasto di [selezione].
La riproduzione verrà riavviata dal punto in cui era stata interrotta.

RICERCA ALL’INTERNO DI UNA TRACCIA
1. Tenere premuto il tasto [Sinistra, Destra] durante la riproduzione della 

traccia selezionata.
Verrà eseguita una ricerca dall’inizio alla fi ne della traccia.

2. Rilasciare il pulsante nel punto in cui si desidera iniziare la riproduzione.
La riproduzione verrà avviata dal punto in cui si è rilasciato il tasto.

RIPRODUZIONE DALL’INIZIO DELLA TRACCIA CORRENTE
Toccare il tasto [Sinistra] dopo 3 secondi dall’inizio della riproduzione.

La traccia corrente verrà riprodotta dall’inizio.

RIPRODUZIONE DELLA TRACCIA PRECEDENTE
Toccare il tasto [Sinistra] entro 3 secondi dall’inizio della riproduzione.
Toccare due volte il tasto [Sinistra] dopo 3 secondi dall’inizio della riproduzione.

Verrà riprodotta la traccia precedente.
Con i fi le VBR (Variable Bit Rate), la traccia precedente potrebbe non venire 
riprodotta neanche se si tocca il tasto [Sinistra] entro 3 secondi.

RIPRODUZIONE DELLA TRACCIA SUCCESSIVA
Toccare il tasto [Destra].

Verrà riprodotta la traccia successiva.

ATTENZIONE
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CREAZIONE DI UNA SEQUENZA BRANI SUL 
LETTORE MP3
Se sul lettore MP3 sono già stati scaricati fi le, è possibile creare una playlist 
“Preferiti”.

1. Tenere premuto il tasto [ ] per passare alla schermata 
del menu principale.

2. Toccare il tasto [Su, Giù, Sinistra, Destra] per selezionare 
<File Browser> (Ricerca File), quindi toccare il tasto di 
[selezione].

3. Toccare il tasto [Su, Giù] per selezionare <Music>
(Musica), quindi toccare il tasto di [selezione].

Viene visualizzato il(i) fi le musicale(i).

4. Toccare il tasto [Su, Giù] per selezionare il fi le da aggiungere alla playlist, 
quindi toccare [ ].

Viene visualizzato il menu Sequenza brani.

5. Toccare il tasto [Su, Giù] per selezionare <Add to Playlist> (Aggiungi a 
Playlist), quindi toccare il tasto di [selezione].

Appare un elenco da <Playlist 1> a <Playlist 5>.

6. Toccare il tasto [Su, Giù] per selezionare il numero della playlist a cui 
aggiungere il fi le selezionato, quindi toccare il tasto di [selezione].

Il fi le selezionato viene aggiunto alla sequenza brani.
La sequenza brani può essere controllata in <Music> (Musica)  <Playlists> (Playlist) 

 da <Playlist 1> a <Playlist 5> nel menu principale.

Ad ogni sequenza brani possono essere aggiunti fi no a 100 fi le musicali 
(da <Playlist 1> a <Playlist 5> ).
Per informazioni su come creare una playlist in <EmoDio> e su come trasferirla sul 
lettore, vedere <EmoDio>.

Music

Rising Sun
My love

Add to Playlist
Delete

1/2

NOTA
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RIPRODUZIONE DI UNA SEQUENZA BRANI
1. Tenere premuto il tasto [ ] per passare alla schermata 

del menu principale.
2. Toccare il tasto [Su, Giù, Sinistra, Destra] per selezionare 

<Music> (Musica), quindi toccare il tasto di [selezione].
Viene visualizzato l’elenco <Music> (Musica).

3. Toccare il tasto [Su, Giù] per selezionare <Playlists>
(Playlist), quindi toccare il tasto di [selezione].

Verranno visualizzate le sequenze di brani.

4. Toccare il tasto [Su, Giù] per selezionare la playlist desiderata, quindi 
toccare il tasto di [selezione].

Vengono visualizzati i fi le musicali memorizzati nella sequenza brani selezionata.
Se non viene trovata nessuna sequenza di brani, verrà visualizzato il messaggio <No 
fi le> (Nessun fi le).

5. Toccare il tasto [Su, Giù] per selezionare un fi le musicale da riprodurre, 
quindi toccare il tasto di [selezione].

Il fi le verrà riprodotto.

Music

Now Playing
Artists
Albums
Songs
Genres
Playlists
Recorded Files
Music Browser
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ELIMINAZIONE DI UN FILE DALLA SEQUENZA BRANI
1. Tenere premuto il tasto [ ] per passare alla schermata 

del menu principale.
2. Toccare il tasto [Su, Giù, Sinistra, Destra] per selezionare 

<Music> (Musica), quindi toccare il tasto di [selezione].
Viene visualizzato l’elenco <Music> (Musica).

3. Toccare il tasto [Su, Giù] per selezionare <Playlists>
(Playlist), quindi toccare il tasto di [selezione].

Verranno visualizzate le sequenze di brani.
4. Toccare il tasto [Su, Giù] per selezionare la playlist 

desiderata, quindi toccare il tasto di [selezione].
Vengono visualizzati i fi le musicali memorizzati nella sequenza 
brani selezionata.

5. Toccare il tasto [Su, Giù] per selezionare un fi le da 
eliminare dalla playlist, quindi toccare [ ].

Viene visualizzato il menu Sequenza brani.
6. Toccare il tasto [Su, Giù] per selezionare <Delete from 

Playlist> (Elimina da Playlist), quindi toccare il tasto di 
[selezione].

Il fi le selezionato viene eliminato dalla sequenza brani.

ELIMINAZIONE DI TUTTI I FILE DALLA SEQUENZA BRANI
Seguire i passi 1-4 sopra esposti.
5. Toccare [ ].

Viene visualizzato il menu Sequenza brani.
6. Toccare il tasto [Su, Giù] per selezionare <Delete All from 

Playlist> (Elimina tutto da Playlist), quindi toccare il tasto
di [selezione].

Tutti i fi le vengono eliminati dalla sequenza brani.

Il fi le selezionato nella sequenza brani non può essere 
eliminato quando è in corso di riproduzione.

Playlists

Playlist 1
Playlist 2
Playlist 3
Playlist 4
Playlist 5

Playlist 1

Rising Sun
My love

1/2

Delete from Playlist
Delete All from Playli..

Playlist 1

Rising Sun
My love

1/2

Delete from Playlist
Delete All from Playlist

NOTA
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UTILIZZO DEL MENU MUSICA
Il menu Musica consente di gestire tutte le funzioni legate all’ascolto - dalla 
ripetizione delle tracce e degli album alla scelta dello sfondo sul display durante 
l’ascolto.

Per impostare l’effetto sonoro
Questa funzione serve per impostare un suono più nitido.
1. Toccare [ ] mentre si sta ascoltando la musica.

Si apre il menu <Music> (Musica).

2. Toccare il tasto [Su, Giù] per selezionare <Sound
Effect> (Effetti Audio), quindi toccare il tasto di 
[selezione].

Si apre il menu <Sound Effect> (Effetti Audio).

3. Toccare il tasto [Su, Giù] per selezionare l’effetto 
audio desiderato, quindi toccare il tasto di 
[selezione].

Scegliere <Street Mode> (Modo strada) o <Audio Upscaler> (Upscaling 
audio).

Opzioni di impostazione dell’effetto sonoro
Street Mode (Modo strada): Consente di ascoltare musica all’aperto in modo 
chiaro e distinto fi ltrando i suoni provenienti dalla strada. Selezionare un valore 
compreso tra 0 e 2.
Audio Upscaler (Upscaling audio): Questa funzione ricostruisce la sorgente 
audio persa con la codifi ca WMA / MP3 nel modo più fedele possibile 
all’originale.Questa funzione è disponibile solo per fi le musicali di bassa qualità.
Selezionare <Off> o <On>.

Per uscire dal menu, premere [ ].
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UTILIZZO DEL MENU MUSICA (Continua)
Per impostare il Digital Natural Sound engine (DNSe)
Seleziona il suono corretto per ogni genere musicale.
1. Toccare [ ] mentre si sta ascoltando la musica.

Si apre il menu <Music> (Musica).

2. Toccare il tasto [Su, Giù] per selezionare 
<DNSe>, quindi toccare il tasto di [selezione].

Si apre il menu <DNSe>.

3. Toccare il tasto [Su, Giù] per selezionare il 
profi lo DNSe desiderato, quindi toccare il tasto di 
[selezione].

Selezionare tra <Auto>, <Normal>(Normale), <Studio>, <Rock>, <Classical> 
(Classica), <Jazz>, <Ballad> (Ballata), <Club>, <Rhythm & Blues>, 
<Dance> (Danza), <Café>, <Concert> (Concerto), <Church> (Chiesa) e 
<myDNSe>.
Se il tag ID3 contiene le informazioni relative al genere musicale del fi le, 
<Auto (Auto)> seleziona automaticamente il modo DNSe corrispondente.
Se si seleziona <myDNSe>, è possibile impostare il DNSe utente. Vedere 
pagina 44.

Che cos’è il DNSe?
Il Digital Natural Sound Engine (DNSe) è un effetto audio per lettori MP3 
sviluppato da Samsung. Offre diverse impostazioni audio per migliorare il 
tipo di musica ascoltata.

Music

Rising Sun

02:13 04:28

Sound Effect
DNSe
Play Mode
Music Play Screen
Play Speed
Skip Interval
Repeat A-B Mode On

NOTA



44 _ ascolto della musica

UTILIZZO DEL MENU MUSICA (Continua)
Per selezionare myDNSe
È possibile impostare un DNSe utente sul lettore o il DNSe utente 
trasferito da <EmoDio>.
1. Toccare [ ] mentre si sta ascoltando la musica.

Si apre il menu <Music> (Musica).

2. Toccare il tasto [Su, Giù] per selezionare 
<DNSe>, quindi toccare il tasto di [selezione].

Si apre il menu <DNSe>.

3. Toccare il tasto [Su, Giù] per selezionare 
<myDNSe>, quindi toccare il tasto di [selezione].

Viene visualizzato l’elenco dei DNSe utente.

4. Toccare il tasto [Su, Giù] per selezionare il DNSe utente desiderato, 
quindi toccare il tasto di [selezione].

Il DNSe utente selezionato viene impostato.
Una volta selezionato <myDNSe>, è possibile impostare i valori <EQ>, 
<3D & BASS> (3D & BASSI), <Concert Hall> (Sala Concerti) e <Clarity> 
(Chiarezza).Vedere pagine 45~48.

Per ulteriori informazioni su come impostare un DNSe utente con 
<EmoDio>, vedere <EmoDio>.
Escludendo le voci da <User 1> (Utente 1) a <User 3> (Utente 3), è 
possibile trasferire sul lettore fi no a 97 impostazioni per il DNSe utente
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UTILIZZO DEL MENU MUSICA (Continua)
Per selezionare myDNSe (Continua)
<EQ>
È possibile regolare le singole frequenze audio.
1. Toccare il tasto [Su, Giù] per selezionare il DNSe 

utente desiderato nel menu myDNSe, quindi 
toccare [ ].

Viene visualizzato il menu dei DNSe utente.

2. Toccare il tasto [Su, Giù] per selezionare <EQ>,
quindi toccare il tasto di [selezione].

Viene visualizzato il display di impostazione <EQ>.

3. Toccare il tasto [Sinistra, Destra] per selezionare 
la frequenza da regolare e il tasto [Su, Giù] per regolare il livello 
della frequenza selezionata.

Per il livello della frequenza si può selezionare da <–10 a +10>.

4. Toccare il tasto di [selezione].
L’impostazione è completata.

myDNSe

User 1
User 2
User 3
EQ
3D & BASS
Concert Hall
Clarity
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UTILIZZO DEL MENU MUSICA (Continua)
Per selezionare myDNSe (Continua)
<3D & BASS> (3D & BASSI)
È possibile impostare l’effetto audio surround 3D e il livello di 
amplifi cazione dei bassi.
1. Toccare il tasto [Su, Giù] per selezionare il DNSe 

utente desiderato nel menu myDNSe, quindi 
toccare [ ].

Viene visualizzato il menu dei DNSe utente.

2. Toccare il tasto [Su, Giù] per selezionare <3D & 
BASS> (3D & BASSI), quindi toccare il tasto di 
[selezione].

Viene visualizzato il display di impostazione 
<3D & BASS> (3D&BASSI).

3. Toccare il tasto [Sinistra, Destra] per selezionare <3D> o <BASS>
(BASSI), quindi toccare il tasto [Su, Giù].

Per <3D> e <Bass> (Bassi) è possibile selezionare un valore compreso tra 
<0 e 4>.

4. Toccare il tasto di [selezione].
L’impostazione è completata.

myDNSe
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UTILIZZO DEL MENU MUSICA (Continua)
Per selezionare myDNSe (Continua)

<Concert Hall> (Sala Concerti)
È possibile regolare la dimensione e il livello della sala concerti come 
se si stesse ascoltando la musica in una vera sala concerti.
1. Toccare il tasto [Su, Giù] per selezionare il DNSe 

utente desiderato nel menu myDNSe, quindi 
toccare [ ].

Viene visualizzato il menu dei DNSe utente.

2. Toccare il tasto [Su, Giù] per selezionare 
<Concert Hall> (Sala Concerti), quindi toccare il 
tasto di [selezione].

Viene visualizzata la schermata di impostazione 
<Concert Hall> (Sala Concerti).

3. Toccare il tasto [Sinistra, Destra] per selezionare <Size>
(Dimensione) o <Level> (Livello) e toccare il tasto [Su, Giù].

Per <Size> (Dimensione) e <Level> (Livello) si può scegliere tra <0-3>.

4. Toccare il tasto di [selezione].
L’impostazione è completata.

Per alcuni fi le musicali, selezionando <Concert Hall> (Sala Concerti) è 
possibile vengano disattivati altri effetti sonori.

myDNSe
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UTILIZZO DEL MENU MUSICA (Continua)
Per selezionare myDNSe (Continua)

<Clarity> (Chiarezza)
Questa funzione serve per impostare un suono più nitido migliorando la 
qualità acustica del suono. 
1. Toccare il tasto [Su, Giù] per selezionare il DNSe 

utente desiderato nel menu myDNSe, quindi 
toccare [ ].

Viene visualizzato il menu dei DNSe utente.

2. Toccare il tasto [Su, Giù] per selezionare 
<Clarity> (Chiarezza), quindi toccare il tasto di 
[selezione].

Viene visualizzata la schermata di impostazione 
<Clarity> (Chiarezza).
È possibile selezionare un valore compreso tra <0 e 2>

3. Toccare il tasto [Su, Giù] per selezionare il livello desiderato, quindi 
toccare il tasto di [selezione].

L’impostazione è completata.

myDNSe

User 1
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User 3
EQ
3D & BASS
Concert Hall
Clarity
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UTILIZZO DEL MENU MUSICA (Continua)
Per impostare il modo di riproduzione
Consente di selezionare la modalità di riproduzione, ad esempio le 
impostazioni di ripetizione.
1. Toccare [ ] mentre si sta ascoltando la musica.

Si apre il menu <Music> (Musica).

2. Toccare il tasto [Su, Giù] per selezionare <Play
Mode> (Riproduzione), quindi toccare il tasto di 
[selezione].

Si apre il menu <Play Mode> (Riproduzione).

3. Toccare il tasto [Su, Giù] per selezionare il modo 
di riproduzione desiderato, quindi toccare il tasto
di [selezione].

Opzioni del modo di riproduzione
Normal (Normale): Riproduce tutti i fi le dell’elenco corrente in sequenza, una 
volta.
Repeat (Ripetere): Ripete la riproduzione di tutti i fi le dell’elenco corrente.
Repeat One (Ripeti una volta): Ripete la riproduzione di un fi le.
Shuffl e : Ripete la riproduzione di tutti i fi le dell’elenco corrente in sequenza 
casuale.
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UTILIZZO DEL MENU MUSICA (Continua)
Per selezionare la schermata di riproduzione 
musicale
Scegliere una delle immagini di sfondo proposte o scegliere 
un’immagine personalizzata da visualizzare durante l’ascolto musicale.
1. Toccare [ ] mentre si sta ascoltando la musica.

Si apre il menu <Music> (Musica).
2. Toccare il tasto [Su, Giù] per selezionare <Music

Play Screen> (Schermo ripr.musica), quindi 
toccare il tasto di [selezione].

Si apre il menu <Music Play Screen> (Schermo ripr.
musica).

3. Toccare il tasto [Sinistra, Destra] per selezionare 
la schermata di riproduzione musicale desiderata, 
quindi toccare il tasto di [selezione].

Music Play Screen Options
Scegliere tra <Refl ection> (Rifl essione), <Auto>, <Passionate> (Passionale), 
<Sweet> (Dolce), <Quiet> (Tranquillo), <Cheerful> (Allegro), <Album Art> 
(Copertina album) e <Album Info> (Info album).
Auto : Cambia automaticamente la schermata di riproduzione musicale a 
seconda delle informazioni nel tag ID3 del fi le musicale.
Album Art (Coper. album): L’immagine di copertina dell’album viene 
visualizzata solo se è inserita nelle informazioni del tag ID3 del fi le musicale. 
Vengono supportate immagini di copertina dell’album di dimensioni inferiori a 
200 pixel (in orizzontale) x 200 pixel (in verticale).
Album Info. (Info album): Le informazioni sul nome dell’artista, sull’album e sul 
genere vengono visualizzate se le informazioni del tag ID3 vengono salvate sul 
fi le musicale.

Che cos’è un’etichetta ID3?
Sono informazioni allegate ai fi le MP3 e relative al brano musicale, ad 
esempio titolo, artista, album, genere, oltre a un campo per i commenti.
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UTILIZZO DEL MENU MUSICA (Continua)
Per impostare la velocità di riproduzione
È possibile velocizzare o rallentare il brano musicale preferito regolando 
la velocità di riproduzione.
1. Toccare [ ] mentre si sta ascoltando la musica.

Si apre il menu <Music> (Musica).

2. Toccare il tasto [Su, Giù] per selezionare <Play
Speed> (Velocità di riproduzione), quindi toccare il 
tasto di [selezione].

Si apre il menu <Play Speed> (Velocita’ di riproduzione).

3. Toccare il tasto [Su, Giù] per selezionare la 
velocità di riproduzione desiderata, quindi toccare 
il tasto di [selezione].

Scegliere tra <Slow3> (Lenta3), <Slow2> (Lenta2), <Slow1> (Lenta1), 
<Normal> (Normale), <Fast1> (Veloce1), <Fast2> (Veloce2) e <Fast3> 
(Veloce3).
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UTILIZZO DEL MENU MUSICA (Continua)
Per impostare la funzione Salta intervallo
È possibile effettuare l’avanzamento rapido di un fi le a diversi intervalli. 
Saltare un’intera traccia o alcuni secondi per volta.
1. Toccare [ ] mentre si sta ascoltando la musica.

Si apre il menu <Music> (Musica).

2. Toccare il tasto [Su, Giù] per selezionare <Skip
Interval> (Salta intervallo), quindi toccare il tasto
di [selezione].

Si apre il menu <Skip Interval> (Salta intervallo).

3. Toccare il tasto [Su, Giù] per selezionare 
l’intervallo di salto desiderato, quindi toccare il 
tasto di [selezione].

Selezionare tra <1 Song> (1 Canzone), <5sec>, <10sec>, <30sec> e 
<1min>.

Se il fi le è stato sviluppato con un bit rate variabile (VBR), la lunghezza 
effettiva dell’intervallo di salto può non essere esattamente quella 
selezionata.
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UTILIZZO DEL MENU MUSICA (Continua)
Per impostare la ripetizione di una sezione
Questa funzione consente di ascoltare ripetutamente la sezione di un 
brano. È consigliata, ad esempio, per lo studio delle lingue
1. Toccare [ ] nel punto desiderato mentre si sta 

ascoltando la musica.
Si apre il menu <Music> (Musica).

2. Toccare il tasto [Su, Giù] per selezionare 
<Repeat A-B Mode On> (Modo Ripetizione A-B 
On), quindi toccare il tasto di [selezione].

Viene visualizzata la schermata di impostazione della 
ripetizione della sezione.

3. Toccare [ ] all’inizio della sezione da ripetere.
Viene impostato il punto di inizio e sulla barra di stato di riproduzione appare 
l’indicazione < >.

4. Toccare di nuovo [ ] per impostare la fi ne della sezione che si 
vuole ripetere.

< > Sulla barra di stato di riproduzione appare l’indicazione e viene avviata 
la riproduzione ripetuta della sezione specifi cata.

Per annullare la ripetizione della sezione
1. Toccare [ ] durante la ripetizione della sezione.

La funzione di ripetizione della sezione viene annullata.

La ripetizione ciclica di una sezione viene automaticamente annullata nel 
seguente caso. 
- Si imposta il punto iniziale della sezione, ma il punto fi nale non viene 

impostato fi nché non termina la traccia corrente.
- Il punto di fi ne è impostato per meno di 3 secondi di riproduzione dopo il 

punto di inizio.
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per vedere un video
Prima di iniziare! - Collegare le cuffi e, quindi accendere il lettore e controllare la 
batteria.
Trasferire un fi le video al lettore utilizzando <EmoDio>. 
Toccare [ ] per passare alla schermata precedente. 
Tenere premuto il tasto [ ] per passare alla schermata del menu principale.

PER VEDERE UN VIDEO
1. Tenere premuto il tasto [ ] per passare alla schermata 

del menu principale.
2. Toccare il tasto [Su, Giù, Sinistra, Destra] per selezionare 

<Videos> (Video), quindi toccare il tasto di [selezione].
Viene visualizzato l’elenco dei fi le video.

3. Toccare il tasto [Su, Giù] per selezionare un video da 
riprodurre e toccare il tasto di [selezione].

Viene avviata la riproduzione orizzontale del 
fi le video selezionato.

MESSA IN PAUSA
1. Toccare il tasto di [selezione] durante la 

riproduzione di video.
Il lettore sospende la riproduzione.

2. Toccare di nuovo il tasto di [selezione].
Il lettore riprende la riproduzione dall’ultimo punto riprodotto.

Prima di trasferire un fi le video sul lettore tramite <EmoDio>, questo viene 
automaticamente convertito in formato SVI. Le dimensioni del fi le vengono 
automaticamente modifi cate. Per ulteriori informazioni, vedere <EmoDio>.

NOTA

NOTA

Tasto [Su, Giù]

Tasto [Sinistra, Destra]
<Visualizzazione orizzontale>
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PER PASSARE AD UN FOTOGRAMMA SPECIFICO
1. In visualizzazione orizzontale, tenere premuto il tasto

[Sinistra, Destra].
Questo consente di spostarsi avanti e indietro nel fi le video 
corrente.

2. Una volta raggiunta la posizione desiderata, rilasciare 
il tasto.

Viene avviata la riproduzione del video dalla posizione 
selezionata.

PER RIPRODURRE IL FILE VIDEO PRECEDENTE
Toccare il tasto [Sinistra] entro 3 secondi dall’inizio 
della riproduzione del fi le corrente.
Toccare due volte il tasto [Sinistra] 3 secondi dopo 
l’inizio della riproduzione del fi le corrente.

Il sistema torna al video precedente.

PER RIPRODURRE IL FILE VIDEO SUCCESSIVO
Toccare il tasto [Destra].

Il sistema salta al video successivo.

Video Track 1

Video Track 1

Video Track 2
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UTILIZZO DEL MENU VIDEO
Per impostare un segnalibro
L’impostazione del segnalibro permette, in seguito, di raggiungere con 
facilità una determinata posizione.
1. Toccare [ ] nella scena desiderata durante 

la riproduzione video.
Si apre il menu <Video>.

2. Toccare il tasto [Su, Giù] per selezionare 
<Add Bookmark> (Aggiungi segnalibro), 
quindi toccare il tasto di [selezione].

Il punto di riproduzione/arresto corrente viene 
aggiunto al segnalibro.
Viene visualizzato il simbolo [ | ] sulla barra di stato di riproduzione.

Se in precedenza è stato impostato un segnalibro, si apre la fi nestra 
Sovrascrivi. Se si seleziona <Yes> (Sì), il segnalibro precedentemente 
impostato viene eliminato e viene aggiunto un nuovo segnalibro.
È possibile impostare un segnalibro per ogni fi le video, ma non si deve 
superare il numero di 50 segnalibri.

Per spostarsi su (riprodurre) / rimuovere il segnalibro
1. Durante la riproduzione video toccare [ ].

Si apre il menu <Video>.

2. Toccare il tasto [Su, Giù] per selezionare 
<Go to Bookmark> (Vai al segnalibro) o 
<Delete Bookmark> (Elimina segnalibro), 
quindi toccare il tasto di [selezione].

Selezionando <Go to Bookmark> (Vai al segnalibro) 
il lettore si sposta al segnalibro selezionato e avvia la riproduzione.
Premendo <Delete Bookmark> (Elimina segnalibro) il sistema rimuove il 
segnalibro selezionato dal fi le video.

Per uscire dal menu, toccare [ ].

Add Bookmark
Go to Bookmark
Delete Bookmark
Brightness
DNSe

Add Bookmark
Go to Bookmark
Delete Bookmark
Brightness
DNSe

NOTA

NOTA
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UTILIZZO DEL MENU VIDEO (Continua)
Per regolare la luminosità
È possibile regolare la luminosità della schermata.
1. Durante la riproduzione video toccare [ ].

Si apre il menu <Video>.

2. Toccare il tasto [Su, Giù] per selezionare 
<Brightness> (Luminosità), quindi toccare il 
tasto di [selezione].

Si apre il menu <Brightness> (Luminosità).

3. Toccare il tasto [Su, Giù] per regolare la luminosità desiderata e 
toccare il tasto di [selezione].

Selezionare tra <0~10>.

Per impostare il Digital Natural Sound engine (DNSe)
Selezionare l’audio adatto per ogni genere di video.
1. Durante la riproduzione video toccare [ ].

Si apre il menu <Video>.

2. Toccare il tasto [Su, Giù] per selezionare 
<DNSe>, quindi toccare il tasto di [selezione].

Si apre il menu <DNSe>.

3. Toccare il tasto [Su, Giù] per selezionare il 
profi lo DNSe desiderato, quindi toccare il tasto di [selezione].

Selezionare tra <Normal> (Normale), <Drama> (Dramma) e <Action> (Azione).

Che cos’è il DNSe?
Il Digital Natural Sound Engine (DNSe) è un effetto audio per lettori MP3 
sviluppato da Samsung. Offre diverse impostazioni audio per migliorare il 
tipo di musica ascoltata.

Add Bookmark
Go to Bookmark
Delete Bookmark
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visualizzazione di immagini
Prima di iniziare! - Collegare le cuffi e, quindi accendere il lettore e controllare lo stato 
della batteria. Trasferire i fi le d’immagine al lettore utilizzando <EmoDIo>.
Toccare [ ] per passare alla schermata precedente. 
Tenere premuto il tasto [ ] per passare alla schermata del menu principale.

VISUALIZZAZIONE DI IMMAGINI
1. Tenere premuto il tasto [ ] per passare alla schermata 

del menu principale.
2. Toccare il tasto [Su, Giù, Sinistra, Destra] per selezionare 

<Pictures> (Immagini), quindi toccare il tasto di [selezione].
Viene visualizzata la fi nestra di anteprima dell’immagine.

3. Toccare il tasto [Su, Giù, Sinistra, Destra] per selezionare 
l’immagine da guardare e toccare il tasto di [selezione].

Viene visualizzata l’immagine selezionata.
Toccare [ ] per passare alla fi nestra di 
anteprima.

Per passare all’immagine 
precedente/successiva
In visualizzazione orizzontale, 
toccare il tasto [Sinistra, Destra].

L’immagine precedente/successiva 
viene visualizzata.

Prima di trasferire un’immagine sul lettore tramite <EmoDio>, questa viene 
automaticamente convertita in formato JPG. Anche le dimensioni del fi le vengono 
automaticamente adattate. Per ulteriori informazioni, vedere <EmoDio>.
Verrà visualizzato  se i fi le JPG contengono informazioni errate sulle miniature.
Alcune immagini possono essere visualizzate lentamente.
È anche possibile utilizzare il <File Browser> (Ricerca File) per cercare 
un’immagine. Vedere pagina 21.

Tasto [Su, Giù]

Tasto [Sinistra, Destra]
<Visualizzazione orizzontale>

NOTA

NOTA
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NOTA

UTILIZZO DEL MENU IMMAGINI
Per vedere immagini durante l’ascolto di musica o 
radio FM
È possibile ascoltare musica o la radio FM mentre si guardano le immagini.
1. Toccare [ ] mentre si visualizza 

un’immagine.
Si apre il menu <Pictures> (Immagini).

2. Toccare il tasto [Su, Giù] per selezionare 
<Music On> (Musica On) o <FM Radio On> 
(Radio FM On), quindi toccare il tasto di 
[selezione].

Ogni volta che si tocca <Music On> (Musica On) o <FM Radio On> (Radio 
FM On) si attiva o disattiva l’audio.

Per vedere una proiezione di diapositive
Fase 1
1. Toccare il tasto di [selezione] durante la 

visualizzazione di un’immagine.
Sulla schermata viene visualizzato [ ] e poi il lettore 
avvia la presentazione.

Fase 2
1. Nel modo di anteprima delle immagini, toccare [ ].

Viene visualizzata la fi nestra Start Slideshow (Avvia 
present.)

2. Toccare il tasto [Su, Giù] per selezionare <Start Slideshow>(Avvia 
present.), quindi toccare il tasto di [selezione].
  Sulla schermata viene visualizzato [ ] e poi il lettore avvia la 
presentazione.

Per uscire dal menu, toccare [ ].

Music On
FM Radio On
Start Sildeshow
Zoom
Rotate
Auto Pivot
Transition Effect
Select as My Skin

Picture Image 1.jpg

1/8Pictures

Start Slideshow
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UTILIZZO DEL MENU IMMAGINI (Continua)
Per arrestare la proiezione di diapositive

Fase 1
1. Nel modo di presentazione toccare il tasto di 

[selezione].
La presentazione si arresta.

Fase 2
1. Nel modo presentazione, toccare [ ].

Si apre il menu <Pictures> (Immagini).

2. Toccare il tasto [Su, Giù] per selezionare <Stop Slideshow>
(Arresta presentazione), quindi toccare il tasto di [selezione].

La presentazione si arresta.

Per impostare la velocità di proiezione diapositive
1. Nel modo presentazione, toccare [ ].

Viene visualizzato il menu della presentazione.

2. Toccare il tasto [Su, Giù] per selezionare 
<Slideshow Speed> (Vel.presentazione), 
quindi toccare il tasto di [selezione].

Si apre il menu <Slideshow Speed> (Vel.
presentazione).

3. Toccare il tasto [Su, Giù] per selezionare la velocità desiderata, 
quindi toccare il tasto di [selezione].

Selezionare tra <Fast> (Veloce), <Normal> (Normale) e <Slow> (Lenta).

Stop Sildeshow
Slideshow Speed
Transition Effect

Stop Sildeshow
Slideshow Speed
Transition Effect
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UTILIZZO DEL MENU IMMAGINI (Continua)
Per ingrandire un’immagine
L’immagine può essere ingrandita.
1. Toccare [ ] mentre si visualizza un’immagine.

Si apre il menu <Pictures> (Immagini).

2. Toccare il tasto [Su, Giù] per selezionare 
<Zoom>, quindi toccare il tasto di 
[selezione].

Si apre il menu <Zoom>.

3. Toccare il tasto [Su, Giù] per selezionare 
la percentuale di zoom desiderata, quindi toccare il tasto di 
[selezione].

Selezionare tra <100%>, <200%> e <400%>.

4. Toccare il tasto [Su, Giù, Sinistra, Destra] per passare alla parte di 
immagine da ingrandire.

Per annullare l’uso dello zoom

Toccare il tasto di [selezione] nella visualizzazione ingrandita 
dell’immagine.

L’immagine ritorna alla dimensione originale.

L’ingrandimento di un fi le di immagine di grandi dimensioni può richiedere 
un po’ di tempo.
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UTILIZZO DEL MENU IMMAGINI (Continua)
Per ruotare le immagini
L’immagine può essere ruotata a piacere
1. Toccare [ ] mentre si visualizza un’immagine.

Si apre il menu <Pictures> (Immagini).

2. Toccare il tasto [Su, Giù] per selezionare 
<Rotate> (Ruota), quindi toccare il tasto di 
[selezione].

Si apre il menu <Rotate> (Ruota).

3. Toccare il tasto [Su, Giù] per selezionare l’angolo desiderato, quindi 
toccare il tasto di [selezione].

Selezionare tra <Left 90°>(A sinistra 90°), <Right 90°>(A destra 90°) e <180°>.

Per impostare la funzione Auto Pivot (Pivot automatico)
La funzione Auto Pivot (Pivot automatico) ruota l’immagine mantenendo 
le proporzioni, in modo che possa essere visualizzata sullo schermo 
con le massime dimensioni possibili.
1. Toccare [ ] mentre si visualizza un’immagine.

Si apre il menu <Pictures> (Immagini).

2. Toccare il tasto [Su, Giù] per selezionare 
<Auto Pivot> (Pivot automatico), quindi 
toccare il tasto di [selezione].

Si apre il menu <Auto Pivot> (Pivot automatico).

3. Toccare il tasto [Su, Giù] per selezionare 
<On>, quindi toccare il tasto di [selezione].

Viene impostata la funzione Auto Pivot (Pivot automatico).
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UTILIZZO DEL MENU IMMAGINI (Continua)
Per cambiare l’effetto transizione
È possibile impostare l’effetto di transizione per il modo in cui l’immagine 
corrente passa a quella precedente o quella successiva.
1. Toccare [ ] mentre si visualizza un’immagine.

Si apre il menu <Pictures> (Immagini).

2. Toccare il tasto [Su, Giù] per selezionare 
<Transition Effect> (Effetto transiz.), quindi 
toccare il tasto di [selezione].

Si apre il menu <Transition Effect> (Effetto transiz.).

3. Toccare il tasto [Su, Giù] per selezionare l’effetto di transizione 
desiderato, quindi toccare il tasto di [selezione].

Scegliere tra <Off>, <Auto>, <Cover> (Copertina), <Fade> (Dissolvenza), 
<Push> (Premi), <Split> (Dividi), <Blinds> (Blind) e <Zoom>.

Per selezionare un’immagine come sfondo
Come sfondo del display si può impostare un’immagine a scelta.
1. Selezionare l’immagine da impostare come 

sfondo e toccare [ ].
Si apre il menu <Pictures> (Immagini).

2. Toccare il tasto [Su, Giù] per selezionare 
<Select as My Skin> (Seleziona come 
sfondo), quindi toccare il tasto di [selezione].

Viene visualizzata la fi nestra di conferma del 
salvataggio.

3. Toccare il tasto [Sinistra, Destra] per selezionare <Yes> (Sì), quindi 
toccare il tasto di [selezione].

L’immagine selezionata viene impostata come sfondo
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divertirsi con il pacchetto premium
Che si tratti di un romanzo, del manoscritto di un nuovo racconto o di un saggio 
scolastico, il lettore MP3 permette di leggere tutto… mentre si ascolta la musica!

Prima di iniziare! - Accendere il lettore e controllare lo stato della batteria.
Trasferire i fi le di testo sul lettore con <EmoDio>. 
Impostare la lingua preferita per il testo. Vedere pagina 69.
Toccare [ ] per passare alla schermata precedente.
Tenere premuto il tasto [ ] per passare alla schermata del menu’ principale

DIVERTIRSI CON IL PACCHETTO PREMIUM
1. Tenere premuto il tasto [ ] per passare alla schermata 

del menu principale.
2. Toccare il tasto [Su, Giù, Sinistra, Destra] per selezionare 

<Texts> (Testi), quindi toccare il tasto di [selezione].
Viene visualizzato l’elenco dei fi le di testo.

3. Toccare il tasto [Su, Giù] per selezionare il fi le di testo 
desiderato, quindi toccare il tasto di [selezione].

Sulla schermata viene visualizzato il testo.
Tenere premuto il tasto di [selezione] per visualizzare a tutto schermo.Per tornare alla 
schermata precedente, tenere nuovamente premuto il tasto di [selezione].

Per spostarsi alla pagina
Toccare il tasto [Sinistra, Destra].

Tenere premuto il tasto [Sinistra, Destra] per passare alla pagina precedente/
successiva.

È anche possibile utilizzare la funzione <File Browser> (Ricerca File) per ricercare 
un fi le di testo. Vedere pagina 21.
Il lettore MP3 supporta il formato TXT in modo testo.

NOTA

NOTA
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UTILIZZO DEL MENU TESTO
Per leggere testi durante l’ascolto di musica o radio FM
È possibile ascoltare musica o la radio FM mentre si leggono testi.
1. Toccare [ ] durante la visualizzazione del testo.

Si apre il menu <Text> (Testo).

2. Toccare il tasto [Su, Giù] per selezionare <Music
On> (Musica On) o <FM Radio On> (Radio FM 
On), quindi toccare il tasto di [selezione].

Ogni volta che si tocca <Music On> (Musica On) o <FM 
Radio On> (Radio FM On) si attiva o disattiva l’audio.

Per spostarsi alla prima pagina
Utilizzare questa funzione per visualizzare il testo dalla prima pagina.
1. Toccare [ ] durante la visualizzazione del testo.

Si apre il menu <Text> (Testo).

2. Toccare il tasto [Su, Giù] per selezionare <Go to 
1st Page> (Vai alla prima pagina), quindi toccare il 
tasto di [selezione].

Viene visualizzata la fi nestra di conferma.

3. Toccare il tasto [Sinistra, Destra] per selezionare 
<Yes> (Sì), quindi toccare il tasto di [selezione].

Salta alla prima pagina.

Per uscire dal menu, toccare [ ].
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UTILIZZO DEL MENU TESTO (Continua)
Per impostare un segnalibro
Impostare un segnalibro per tornare a quel punto del testo in qualsiasi 
momento.
1. Toccare [ ] nella pagina desiderata, mentre viene 

visualizzato un testo.
Si apre il menu <Text> (Testo).

2. Toccare il tasto [Su, Giù] per selezionare <Add
Bookmark> (Aggiungi segnalibro), quindi toccare 
il tasto di [selezione].

Sul testo corrente viene impostato un segnalibro con il 
simbolo [ ] visualizzato in alto a sinistra.

Se in precedenza è stato impostato un segnalibro, 
si apre la fi nestra Sovrascrivi. Se si seleziona <Yes> (Sì), il segnalibro 
precedentemente impostato viene eliminato e viene aggiunto un nuovo 
segnalibro.
Può essere impostato un segnalibro per ogni fi le di testo e non è possibile 
impostare più di 50 segnalibri.

Per spostarsi su / rimuovere un segnalibro
1. Toccare [ ] durante la visualizzazione del testo.

Si apre il menu <Text> (Testo).

2. Toccare il tasto [Su, Giù] per selezionare <Go
to Bookmark> (Vai al segnalibro) o <Delete
Bookmark> (Elimina segnalibro), quindi toccare il 
tasto di [selezione].

Una volta selezionato <Go to Bookmark> (Vai al 
segnalibro), il sistema si sposta al relativo segnalibro; 
premendo <Delete> (Elimina) il sistema rimuove il 
segnalibro selezionato dal fi le di testo.
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UTILIZZO DEL MENU TESTO (Continua)
Per impostare il colore di visualizzazione del testo
Scegliere il colore desiderato per il testo.
1. Toccare [ ] durante la visualizzazione del testo.

Si apre il menu <Text> (Testo).

2. Toccare il tasto [Su, Giù] per selezionare <Text 
Viewer Color> (Col.visual.testo), quindi toccare il 
tasto di [selezione].

Viene visualizzata la fi nestra del menu <Text Viewer 
Color> (Col.visual.testo).

3. Toccare il tasto [Sinistra, Destra] per selezionare il 
colore desiderato per la visualizzazione del testo e toccare il tasto di 
[selezione].

Scegliere tra <Type 1> (Tipo 1) e <Type 6> (Tipo 6).

Per cambiare la dimensione font
È possibile cambiare la dimensione font del testo.
1. Toccare [ ] durante la visualizzazione del testo.

Si apre il menu <Text> (Testo).

2. Toccare il tasto [Su, Giù] per selezionare <Font
Size> (Dimensione font), quindi toccare il tasto di 
[selezione].

Si apre il menu <Font Size> (Dimensione font).

3. Toccare il tasto [Sinistra, Destra] per selezionare 
la dimensione desiderata per il font e toccare il tasto di [selezione].

Selezionare tra <Small> (Piccolo), <Medium> (Mezzo) e <Large> (Grande).
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UTILIZZO DEL MENU TESTO (Continua) 
Impostazione del tipo di visualizzazione del testo
È possibile visualizzare il testo orizzontalmente o verticalmente.
1. Toccare [ ] durante la visualizzazione del testo.

Si apre il menu Text (Testo).

2. Toccare il tasto [Su, Giù] per selezionare <View 
Type> (Visualizza tipo), quindi toccare il tasto di 
[selezione].

Si apre il menu <View Type> (Visualizza tipo).

3. Toccare il tasto [Su, Giù] per selezionare il tipo 
visualizzazione desiderato e toccare il tasto di 
[selezione].

Selezionare tra <Normal> (Normale) e <Horizontal> (Orizzontale).
Selezionare <Normal> (Normale) per visualizzare il testo in verticale e 
<Horizontal> (Orizzontale) per ruotarlo in orizzontale.
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UTILIZZO DEL MENU TESTO (Continua) 
Per impostare la lingua del testo
È possibile selezionare una lingua per il testo da visualizzare.
1. Toccare [ ] durante la visualizzazione del testo.

Si apre il menu Text (Testo).

2. Toccare il tasto [Su, Giù] per selezionare 
<Language> (Lingua), quindi toccare il tasto di 
[selezione].

Viene visualizzato l’elenco <Language> (Lingua).
<English>, <Korean>, <French>, <German>, <Italian>, 
<Japanese>, <Chinese(S)>, <Chinese(T)>, <Spanish>, 
<Russian>, <Hungarian>, <Dutch>, <Polish>, 
<Portuguese>, <Swedish>, <Thai>, <Finnish>, <Danish>, <Norwegian>, 
<Farsi>, <Afrikaans>, <Basque>, <Catalan>, <Czech>, <Estonian>, 
<Greek>, <Hrvatski>, <Icelandic>, <Rumanian>, <Slovak>, <Slovene>, 
<Turkish>, <Vietnamese>.

3. Toccare il tasto [Su, Giù] per selezionare la lingua desiderata, 
quindi toccare il tasto di [selezione].

È possibile visualizzare il testo nella lingua selezionata.

Le lingue supportate possono essere modifi cate o aggiunte.
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UTILIZZO DEL MENU TESTO (Continua) 
Per ascoltare un TTS (sintesi vocale)
La funzione TTS di <EmoDio> consente di convertire un fi le di testo in 
un fi le TTS e ascoltarlo.

Prima di cominciare - Trasferire i fi le TTS al lettore con <EmoDio>.

1. Tenere premuto il tasto [ ] per passare alla schermata del menu 
principale.

2. Toccare il tasto [Su, Giù, Sinistra, Destra] per selezionare <Texts> 
(Testi), quindi toccare il tasto di [selezione].

Viene visualizzato l’elenco dei fi le TTS.

3. Toccare il tasto [Su, Giù] per selezionare un TTS scaricato e 
toccare il tasto di [selezione].

È possibile ascoltare il fi le.

È possibile regolare la velocità di riproduzione e l’intervallo di salto 
toccando [ ].

Per ulteriori informazioni sulla funzione TTS di <EmoDio>, vedere 
<EmoDio>.

NOTA
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ascolto della radio FM
Prima di iniziare! - Collegare le cuffi e, quindi accendere il lettore e controllare lo 
stato della batteria.
Toccare [ ] per passare alla schermata precedente. 
Tenere premuto il tasto [ ] per passare alla schermata del menu principale.

ASCOLTO DELLA RADIO FM
1. Tenere premuto il tasto [ ] per passare alla schermata 

del menu principale.
2. Toccare il tasto [Su, Giù, Sinistra, Destra] per selezionare 

<FM Radio> (Radio FM), quindi toccare il tasto di 
[selezione].

Verrà visualizzato il menu Sensibilità FM.

PER UTILIZZARE LA FUNZIONE DI 
AZZERAMENTO DELL’AUDIO
1. Toccare il tasto di [selezione] mentre si ascolta la radio FM.

L’audio verrà azzerato.

2. Toccare nuovamente il tasto di [selezione] per riprendere l’ascolto.

Durante la ricerca o l’impostazione della frequenza, collegare sempre le cuffi e 
all’apparecchio.
Le cuffi e vengono utilizzate come antenna per ricevere le frequenze radio FM.
Nelle aree in cui la ricezione è bassa, è possibile che il lettore non trovi la frequenza 
della radio FM.

NOTA

NOTA
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RICERCA DELLE STAZIONI FM
1. Tenere premuto il tasto [Sinistra, Destra] e rilasciarlo in 

Manual mode (Modo Manuale).
La ricerca si arresta sulla frequenza più vicina al punto in cui è 
stato rilasciato il tasto.

OPPURE,

1. Toccare il tasto [Sinistra, Destra] per scorrere in avanti 
le frequenze una dopo l’altra in Manual mode (Modo 
Manuale).

Le frequenze verranno cercate ogni volta che si preme il tasto.

Auto Searching

News
Today Headline
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UTILIZZO DEL MENU DELLA RADIO FM
Per passare in modalità di preselezione
Selezionare questa modalità per effettuare manualmente la ricerca delle 
sequenze FM preselezionate scorrendole una alla volta.
1. Toccare [ ] in Manual mode (Modo Manuale).

Si apre il menu <FM Radio> (Radio FM).

2. Toccare il tasto [Su, Giù] per selezionare <Go to 
Preset Mode> (Vai a modo predef.), quindi toccare 
il tasto di [selezione].

Sullo schermo verrà visualizzato l’indicatore <Preset>.

Se non sono presenti frequenze preimpostate, il 
lettore non passa al modo di preimpostazione.

Per passare in modalità manuale
Selezionare questa modalità per effettuare manualmente la ricerca delle 
frequenze FM scorrendole una alla volta.
1. Toccare [ ] in Preset mode (Modalità 

Preselezione).
Si apre il menu <FM Radio> (Radio FM).

2. Toccare il tasto [Su, Giù] per selezionare <Go
to Manual Mode> (Vai a modo manuale), quindi 
toccare il tasto di [selezione].

Sullo schermo viene visualizzato <Manual> (Manuale).

Go to Preset Mode
Add to Preset
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UTILIZZO DEL MENU DELLA RADIO FM (Continua)
Memorizzazione delle stazioni nella memoria 
preimpostata
È possibile impostare fi no a 30 stazioni nella memoria del lettore 
MP3 e richiamarle premendo un solo numero. Memorizzare sul 
lettore MP3 solo le stazioni desiderate con la procedura manuale 
oppure rintracciare e memorizzare le stazioni locali con la procedura 
automatica.
Manuale - per scegliere solo le stazioni che si desidera 
memorizzare
1. Toccare il tasto [Sinistra, Destra] per selezionare 

una frequenza da memorizzare in modo manuale, 
quindi toccare [ ].

Si apre il menu <FM Radio> (Radio FM).

2. Toccare il tasto [Su, Giù] per selezionare <Add
to Preset> (Agg. a Preimpost.), quindi toccare il 
tasto di [selezione].

La frequenza selezionata verrà aggiunta alla lista delle 
preselezioni.

3. Per impostare altre frequenze preimpostate, seguire i passi 1-2 sopra 
esposti.

Se la frequenza scelta è già impostata, l’impostazione appare come 
disabilitata.
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UTILIZZO DEL MENU DELLA RADIO FM (Continua)
Memorizzazione delle stazioni nella memoria 
preimpostata (Continua)
Automatico – per memorizzare automaticamente tutte le stazioni 
che riceve il lettore
1. Toccare [ ] nel modo radio FM.

Si apre il menu <FM Radio> (Radio FM).

2. Toccare il tasto [Su, Giù] per selezionare <Auto
Preset> (Preimp. Auto), quindi toccare il tasto di 
[selezione].

Viene visualizzata la fi nestra di conferma.

3. Toccare il tasto [Sinistra, Destra] per selezionare 
<Yes> (Sì), quindi toccare il tasto di [selezione].

Vengono impostate automaticamente fi no a 30 frequenze.

Per annullare la preimpostazione automatica
Per annullare la preimpostazione automatica, toccare il tasto di 
[selezione] durante l’operazione.

La preimpostazione automatica viene eliminata e vengono memorizzate soltanto 
le frequenze impostate fi no a quel momento.

Se ascoltate il lettore MP3 in una città diversa può essere necessario 
reimpostare le stazioni memorizzate. Per eliminare le stazioni preimpostate 
e memorizzarne delle altre, non si deve far altro che ripetere il processo.
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UTILIZZO DEL MENU DELLA RADIO FM (Continua)
Ascolto delle stazioni preimpostate
In modo di preimpostazione, toccare il tasto
[Sinistra, Destra] per scorrere le stazioni 
preimpostate.

È possibile ascoltare la frequenza radio memorizzata.

Per eliminare una preimpostazione
Seguire le istruzioni fornite per eliminare le frequenze durante l’ascolto
delle stazioni radio FM.
1. In modo di preimpostazione, toccare il tasto

[Sinistra, Destra] per cercare una frequenza 
preimpostata da eliminare, quindi toccare [ ].

Si apre il menu <FM Radio> (Radio FM).

2. Toccare il tasto [Su, Giù] per selezionare <Delete
from Preset> (Elim.da preimpost.), quindi toccare 
il tasto di [selezione].

La frequenza selezionata viene eliminata.

3. Per eliminare le altre frequenze preimpostate, seguire i passi 1-2 
indicati in precedenza.

Go to Manual Mode
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UTILIZZO DEL MENU DELLA RADIO FM (Continua)
Per registrare la trasmissione radio FM
La trasmissione radio FM può essere registrata in qualsiasi momento 
mentre si ascolta la radio.
1. Toccare il tasto [Sinistra, Destra] per selezionare 

una frequenza da registrare in modo Radio FM, 
quindi toccare [ ].

Si apre il menu <FM Radio> (Radio FM).
2. Toccare il tasto [Su, Giù] per selezionare <Start 

Recording> (Avvio registrazione), quindi toccare il 
tasto di [selezione].

Viene visualizzato un nome fi le creato automaticamente 
e viene avviata la registrazione.

Per arrestare la registrazione
1. Toccare il tasto di [selezione] durante la registrazione.

Viene visualizzato un messaggio in cui si richiede se si 
desidera ascoltare il fi le appena registrato.

2. Toccare il tasto [Sinistra, Destra] per selezionare 
<Yes> (Sì) o <No>, quindi toccare il tasto di 
[selezione].

Selezionando <Yes> (Sì) viene riprodotto il fi le appena 
registrato.
Selezionando <No> il fi le registrato non viene riprodotto.

Il fi le registrato è memorizzato in <File Browser> (Ricerca File)  <Recorded 
fi les> (File Registrati) 
La durata massima di ogni fi le registrato dalla radio è di 5 ore.
Il numero massimo di fi le registrabili dalla radio è 999.
Una registrazione può durare fi no a circa 15 ore. (a 128Kbps, 1GB)
Al fi le registrato viene assegnato automaticamente un nome, ad esempio 
“FM_AAMMGG_XXX.MP3. “FM” indica che il fi le è stato registrato dalla radio, 
“AAMMGG” indica la data di registrazione e “XXX” è il numero del fi le.

FM Record

Go to Preset Mode
Add to Preset
Auto Preset
Start Recording
FM Sensitivity
FM Region

NOTA
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Go to Preset Mode
Add to Preset
Auto Preset
Start Recording
FM Sensitivity
FM Region

UTILIZZO DEL MENU DELLA RADIO FM (Continua)
Per impostare la Sensibilità FM
Per ricevere un numero superiore o inferiore di frequenze radio FM, 
regolare <FM Sensitivity> (Sensibilità FM).
1. Toccare [ ] nel modo radio FM.

Si apre il menu <FM Radio> (Radio FM).

2. Toccare il tasto [Su, Giù] per selezionare <FM
Sensitivity> (Sensibilità FM), quindi toccare il 
tasto di [selezione].

Si apre il menu <FM Sensitivity> (Sensibilità FM).

3. Toccare il tasto [Su, Giù] per selezionare il livello 
di ricerca e toccare il tasto di [selezione].

Scegliere tra <High> (Alta), <Middle> (Centrale) e <Low> (Bassa).
Selezionando <High> (Alta), vengono ricevute più frequenze.

Per uscire dal menu, toccare [ ].
NOTA
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UTILIZZO DEL MENU DELLA RADIO FM (Continua)
Per impostare la regione FM
È possibile cambiare l’impostazione della regione FM in vista di un 
viaggio.
1. Toccare [ ] nel modo radio FM.

Si apre il menu <FM Radio> (Radio FM).

2. Toccare il tasto [Su, Giù] per selezionare <FM
Region> (Regione Radio), quindi toccare il tasto
di [selezione].

Si apre il menu <FM Region> (Regione Radio).

3. Toccare il tasto [Su, Giù] per selezionare la 
zona della radio FM, quindi toccare il tasto di 
[selezione].

Scegliere tra <Korea/US> (Corea/USA), <Japan> (Giappone) e <Other 
Countries> (Altri Paesi).

Le frequenze radio precedentemente memorizzate vengono eliminate 
quando si cambia <FM Region> (Regione Radio) sul lettore.

La regione FM può essere eliminata o modifi cata in base all’area d’uso del 
lettore.

Gamma di frequenza in base alla regione
- Korea/US (Corea/US): Cerca le frequenze FM dei lettori da 100 kHz

comprese tra 87,5 MHz e 108,0 MHz.
- Japan (Giappone): Cerca le frequenze FM dei lettori da 100 kHz 

comprese tra 76,0 MHz e 108,0 MHz.
- Other Countries (Altri Paesi): Cerca le frequenze FM dei lettori da 50 kHz 

comprese tra 87,50 MHz e 108,00 MHz.

Go to Preset Mode
Add to Preset
Auto Preset
Start Recording
FM Sensitivity
FM Region

NOTA
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Datacasts 1/4

Datacast 1
Datacast 2
Datacast 3
Datacast 4

Visualizzazione di datacast
VISUALIZZAZIONE DI DATACAST
È possibile visualizzare i post dei canali aggiunti a <Datacasts>.

Prima di iniziare! -  Trasferire i post del canale desiderato sul lettore usando 
<EmoDio>.

Cosa signifi ca Datacast?
È possibile ricevere automaticamente informazioni aggiornate senza dovere visitare 
ogni volta i siti di notizie, i blog e gli UCC.
Toccare [ ] per passare alla schermata precedente. 
Tenere premuto il tasto [ ] per passare alla schermata del menu principale.

1. Tenere premuto il tasto [ ] per passare alla schermata del 
menu principale.

2. Toccare il tasto [Su, Giù, Sinistra, Destra] per selezionare 
<Datacasts> (Datacast), quindi toccare il tasto di 
[selezione].

Viene visualizzato l’elenco Datacast.

3. Toccare il tasto [Su, Giù] per selezionare l’elenco di canali 
desiderato e toccare il tasto di [selezione].

Viene visualizzato l’elenco dei fi le.

Icona : testo principale per la 
posta trasferita
 Icona : fi le immagini

Icona : fi le 
musicale
Icona : fi le video

4. Toccare il tasto [Su, Giù] per selezionare il fi le desiderato 
e toccare il tasto di [selezione].

Verrà avviata la riproduzione del fi le selezionato.
Per informazioni dettagliate vedere <Datacasts> (Datacast) di <EmoDio>.

NOTA

NOTA



divertirsi con il pacchetto premium_ 81

divertirsi con il pacchetto premium
Il pacchetto Premium mette a disposizione varie funzioni quali giochi, 
registrazione vocale, ecc.

Prima di iniziare! - Collegare le cuffi e, quindi accendere il lettore e controllare lo 
stato della batteria.

REGISTRAZIONE VOCALE
Consente di effettuare una registrazione vocale.

Per registrare una voce
1. Tenere premuto il tasto [ ] per passare alla 

schermata del menu principale.
2. Toccare il tasto [Su, Giù, Sinistra, Destra] per 

selezionare <Prime Pack> (Pacchetto Premium), 
quindi toccare il tasto di [selezione].

Viene visualizzato l’elenco <Prime Pack> (Pacchetto 
Premium).

3. Toccare il tasto [Sinistra, Destra] per selezionare 
<Voice REC> (Reg. vocale), quindi toccare il tasto
di [selezione].

4. Toccare il tasto di [selezione].
Il lettore avvia la registrazione.

Il fi le registrato è memorizzato in <File Browser> (Ricerca File) 
<Recorded fi les> (File Registrati) 
La durata massima di ogni fi le di registrazione vocale è di 5 ore.
Il numero massimo di fi le registrabili è 999.
Una registrazione può durare fi no a circa 15 ore. (a 128Kbps, 1GB)
Al fi le registrato viene assegnato automaticamente un nome, ad esempio 
“VCE_AAMMGG_XXX.MP3. “VCE” indica che si tratta di una registrazione 
vocale, “AAMMGG” indica la data di registrazione e “XXX” è il numero del fi le.

NOTA
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REGISTRAZIONE VOCALE (Continua)
Per arrestare la registrazione vocale
1. Toccare il tasto di [selezione] durante la 

registrazione.
Viene visualizzato un messaggio in cui si richiede se si 
desidera ascoltare il fi le appena registrato.

2. Toccare il tasto [Sinistra, Destra] per selezionare 
<Yes> (Sì) o <No>, quindi toccare il tasto di 
[selezione].

Selezionando <Yes> (Sì) viene riprodotto il fi le appena 
registrato.
Selezionando <No> il fi le registrato non viene riprodotto.

Evitare di collocare il microfono troppo vicino o troppo lontano dalla bocca 
per non compromettere la qualità della registrazione.
La registrazione vocale non viene effettuata correttamente se la batteria è 
scarica.

Voice Record

ATTENZIONE
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UTILIZZO DEI VIDEOGIOCHI
Il lettore MP3 viene offerto con una serie di giochi divertenti già caricati!

Toccare [ ] per passare alla schermata precedente. 
Tenere premuto il tasto [ ] per passare alla schermata del menu principale.

1. Tenere premuto il tasto [ ] per passare alla schermata 
del menu principale.

2. Toccare il tasto [Su, Giù, Sinistra, Destra] per selezionare 
<Prime Pack> (Pacchetto Premium), quindi toccare il 
tasto di [selezione].

Viene visualizzato l’elenco <Prime Pack> (Pacchetto Premium).

3. Toccare il tasto [Sinistra, Destra] per selezionare 
<Games> (Gioco), quindi toccare il tasto di [selezione].

Viene visualizzato l’elenco dei giochi.

4. Toccare il tasto [Su, Giù] per selezionare il gioco desiderato, quindi toccare il 
tasto di [selezione].

BOMB BOMB
Si tratta di un gioco di intelligenza che consiste nel cambiare l’ordine dei 
tre blocchi per accoppiare il colore del blocco che funge da martello con 
il colore di quelli impilati, rimuovendo così i blocchi. 
L’obiettivo è rimuovere il maggior numero possibile di 
blocchi.
Toccare il tasto [Sinistra, Destra] per spostare i 
blocchi a sinistra o a destra.
Toccare il tasto [Su] per variare la posizione dei 
blocchi in orizzontale o verticale.
Toccare il tasto [Giù] per lasciar cadere i blocchi.

NOTA
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UTILIZZO DEI VIDEOGIOCHI (Continua)
Bubble Smile
L’obiettivo è accumulare il maggior numero possibile di punti cambiando 
l’ordine di tre bollicine per farle combaciare in orizzontale o in diagonale.

Toccare il tasto [Su, Giù, Sinistra, Destra] per 
spostare la combinazione di tre palle.
Toccare [ ] per cambiare l’ordine delle palle in 
senso orario.
Toccare [ ] per cambiare l’ordine delle palle in 
senso antiorario
Si guadagnano punti solo se si riesce a far 
combaciare almeno tre bollicine.

Chicken Runaway
In questo gioco si spostano la gallina e i pulcini facendoli correre a 
destra o a sinistra. Per esempio, si devono evitare le palle che cadono 
dal cielo per proteggere la gallina il più a lungo possibile.

Toccare il tasto [Sinistra, Destra] per far spostare la 
gallina a destra o a sinistra.

I giochi possono essere aggiunti o modifi cati senza preavviso.
Per ulteriori informazioni vedere la sezione Guida.NOTA
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VISUALIZZAZIONE DELLA CARTINA DELLE 
METROPOLITANE NEL MONDO
È possibile sfogliare la cartina delle metropolitane nel mondo e osservare i posti 
vicino alle stazioni.
1. Tenere premuto il tasto [ ] per passare alla schermata 

del menu principale.
2. Toccare il tasto [Su, Giù, Sinistra, Destra] per selezionare 

<Prime Pack> (Pacchetto Premium), quindi toccare il 
tasto di [selezione].

Viene visualizzato l’elenco <Prime Pack> (Pacchetto Premium).
3. Toccare il tasto [Sinistra, Destra] per selezionare <Subway>

(Metropolitana), quindi toccare il tasto di [selezione].
Viene visualizzata la schermata per la selezione di un continente.

4. Toccare il tasto [Su, Giù, Sinistra, Destra] per selezionare la regione 
desiderata e toccare il tasto di [selezione].

Le opzioni disponibili sono <AMERICA>, <EUROPE> (EUROPA), <ASIA/OCEANIA>.
Vengono visualizzate le città della regione selezionata.

5. Toccare il tasto [Sinistra, Destra] per selezionare la città desiderata e 
toccare il tasto di [selezione].

Viene visualizzata la cartina della metropolitana della città selezionata.
6. Toccare il tasto [Su, Giù, Sinistra, Destra] per selezionare un’area da 

ingrandire e toccare il tasto di [selezione].
Se la mappa ingrandita comprende informazioni su attrazioni turistiche nei 
pressi della stazione della metropolitana, toccare di nuovo il tasto di [selezione] 
per visualizzare la freccia rossa.Utilizzare il tasto [Su, Giù, Sinistra, Destra] per 
selezionare l’icona desiderata, quindi toccare il tasto di [selezione].Così è possibile 
scoprire qual è l’attrazione turistica.
Toccare [ ] per tornare alla schermata di selezione dei continenti.
Vi possono essere delle differenze rispetto alla reale cartina della metropolitana.NOTA
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risoluzione dei problemi
In caso di problemi con il nuovo lettore mp3, cercare la soluzione in 
questo elenco. Se il problema persiste, contattare il più vicino Centro di 
Assistenza Samsung.

PROBLEMA SOLUZIONE

Il lettore non si 
accende.

• Il lettore non si accende se la batteria è 
completamente scarica. Ricaricare la batteria e 
provare di nuovo.

• Premere il foro di reset.

I tasti non funzionano.

• Controllare se l’interruttore [ ] è 
posizionato verso la parte superiore del lettore.

• Controllare di avere premuto il tasto corretto, 
quindi provare a premerlo di nuovo.

• Premere il foro di reset.

Lo schermo non si 
accende.

• In caso di luce solare diretta, lo schermo 
potrebbe non essere visibile.

• <Display Off> (Schermo Off) nel menu 
<Settings> (Impostazioni) <Display>, lo 
schermo si spegne.
Premere un tasto qualsiasi e verifi care che si 
attivi.
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PROBLEMA SOLUZIONE

Il lettore si spegne.

• Il lettore si spegne automaticamente quando la 
batteria è completamente scarica. Ricaricare la 
batteria.

• Se si seleziona <Auto Power Off>
(Spegnimento automatico disattivato) nel 
menu <Settings> (Impostazioni) <System>
(Sistema), l’alimentazione viene disattivata 
quando il lettore è in modo pausa. 
È necessario riaccendere l’apparecchio.

La durata della batteria 
è diversa da quella 
indicata nel manuale.

• La durata della batteria può variare a seconda 
della modalità audio e delle impostazioni dello 
schermo.

• L’esposizione del lettore a temperature basse o 
alte può ridurne la durata.

Malfunzionamento del 
programma EmoDio

• Verifi care che il PC risponda ai requisiti di 
sistema di base.

Il collegamento al PC è 
disattivato.

• Verifi care che il cavo USB sia collegato 
correttamente e riprovare.

• Eseguire Windows Update sul PC.Selezionare 
gli aggiornamenti fondamentali e i Service 
Pack ed eseguire l’aggiornamento.Riavviare il 
PC e rieffettuare la connessione.

La velocità di 
trasferimento del fi le è 
troppo bassa.

• Se ci sono diversi programmi in esecuzione 
sul PC, compreso <EmoDio>, la velocità di 
trasferimento dei fi le si riduce. Uscire dai 
programmi non necessari, quindi riprovare a 
trasferire il fi le.
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PROBLEMA SOLUZIONE

Il lettore non effettua la 
riproduzione.

• Controllare se i fi le sono stati salvati nella 
memoria.

• Controllare che i fi le non siano danneggiati.
• Controllare se la batteria è suffi cientemente 

carica.

Il fi le non viene 
caricato.

• Controllare se il cavo USB è collegato 
correttamente. Ricollegarlo, se necessario.

• Controllare se la memoria è piena.
• Premere il foro di reset.

Mancano alcuni fi le o 
dati.

• Controllare se il cavo USB è stato scollegato 
durante la trasmissione dei fi le o dei dati. In 
caso affermativo, potrebbero verifi carsi gravi 
danni non solo ai fi le/dati, ma anche al lettore. 
Prestare molta attenzione in quanto Samsung 
non è responsabile per eventuali perdite di 
dati.

Il tempo di riproduzione 
indicato è errato.

• Controllare se il fi le è in formato VBR 
(Variable Bit Rate).

Il prodotto è caldo.
• Durante la ricarica della batteria il prodotto 

potrebbe scaldarsi. Ciò non ha alcun effetto 
sulla vita utile o sulle funzioni del prodotto.

Viene visualizzato un 
messaggio mentre si 
vede un video.

• Tentare di scaricare di nuovo il video 
utilizzando EmoDio.
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appendice
ALBERO DEI MENU
Di seguito viene fornita una breve presentazione sulla struttura dei menu e delle 
funzioni del nuovo lettore mp3.

Schermata di selezione dei menu

Music Videos Pictures Texts  FM Radio Datacasts Prime Pack File Browser Settings

Voice REC Menu Style

Games Sound

Subway Display

Language

Date&Time

System

Sound
Effect

Add
Bookmark Music On Music On

Go to Preset 
Mode /

Go to Manual 
Mode

DNSe Go to 
Bookmark

FM Radio 
On FM Radio On

Add to Preset /
Delete from 

Preset

Play Mode Delete
Bookmark

Start
Slideshow

Go to 1st 
Page Auto Preset

Music Play 
Screen Brightness Zoom Add

Bookmark
Start

Recording

Play
Speed DNSe Rotate Go to 

Bookmark FM Sensitivity

Skip
Interval Auto Pivot Delete

Bookmark FM Region

Repeat
A-B Mode 

On
Transition 

Effect
Text Viewer 

Color

Select as 
My Skin Font Size

View Type

Language
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SPECIFICHE DEL PRODOTTO
Nome modello YP-Q1
Regolazione DC 5.0V / 500mA
Batteria incorporata 620 mAh/ DC 3.7V
File Compatibilità AUDIO: MPEG1/2/2.5 Layer3 (8kbps ~ 320kbps, 

22kHz ~ 48kHz), WMA (8kbps ~ 320kbps, 
8kHz ~ 48kHz)

VIDEO: SVI (Video: MPEG4, audio: MP3 
(44,1kHz, 128Kbps)), WMV (Video : Profi lo 
semplice WMV9, audio: WMA Spec (max 
860kbps), risoluzione: 320X240, frequenza 
fotogrammi: 30fps)

IMMAGINE: JPEG (ISO/IEC 10918-1/modo Annex 
F-Sequential DCT)

Numero di cartelle/fi le 
supportato

Cartella: Max 1000 / File: Max 6000 (cartella 
compresa)

Uscita cuffi e 20mW/Ch. (Francia 5mW/Ch). (su 16 )
Gamma frequenza di uscita 40 Hz~20 kHz
Rapporto segnale/rumore 90 dB
Tempo di riproduzione Musica: 30 ore max (MP3 128kbps, Volume: 15, 

modo audio normale , LCD spento)
Video:  Max. 4 ore (luminosità 5, volume: 15, 

modo audio normale)
Temperatura di funzionamento -5~35°C (23~95°F)
Custodia Plastica
Peso 65 g
Dimensioni (LxAxP) 51 X 98 X 10.9 mm



appendice _ 91

Radio FM Frequenza FM 87.5~108.0 MHz T.H.D. FM 1%
Rapporto segnale 
FM - rumore 55 dB Sensibilità

FM utile 38 dB

Il contenuto di questo manuale è soggetto a modifi che senza preavviso, al fi ne 
di migliorare le prestazioni del prodotto.
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LICENZA
L’unità allegata al presente manuale d’uso viene concessa in licenza nel rispetto dei 
diritti di proprietà intellettuale delle terze parti specifi cate. La licenza è circoscritta 
all’uso privato non commerciale da parte di utenti fi nali che utilizzano il contenuto 
concesso in licenza. Non sono concessi diritti per l’utilizzo commerciale. La licenza 
non copre altri prodotti diversi da questa unità e non si estende ad altri prodotti 
o processi conformi alle norme ISO/IEC 11172-3 o ISO/IEC 13818- 3 utilizzati o 
venduti in combinazione con questo prodotto. La licenza copre esclusivamente 
l’uso di questo prodotto per la codifi ca e/o decodifi ca di fi le audio in conformità alla 
norma ISO/IEC 11172-3 o ISO/IEC 13818-3. Nell’ambito della presente licenza non 
vengono concessi diritti per funzioni o caratteristiche del prodotto non conformi alla 
norma ISO/IEC 11172-3 oppure ISO/IEC 13818-3.

CORRETTO SMALTIMENTO DEL PRODOTTO 
(RIFIUTI ELETTRICI ED ELETTRONICI)
(Applicabile in i paesi dell’Unione Europea e in quelli con sistema di raccolta 
differenziata) 
Il marchio riportato sul prodotto o sulla sua documentazione 
indica che il prodotto non deve essere smaltito con altri rifi uti 
domestici al termine del ciclo di vita.  Per evitare eventuali danni 
all’ambiente o alla salute causati dall’inopportuno smaltimento 
dei rifi uti, si invita l’utente a separare questo prodotto da altri 
tipi di rifi uti e di riciclarlo in maniera responsabile per favorire il 
riutilizzo sostenibile delle risorse materiali.
Gli utenti domestici sono invitati a contattare il rivenditore presso 
il quale è stato acquistato il prodotto o l’uffi cio locale preposto 
per tutte le informazioni relative alla raccolta differenziata e 
al riciclaggio per questo tipo di prodotto. Gli utenti aziendali 
sono invitati a contattare il proprio fornitore e verifi care i termini 
e le condizioni del contratto di acquisto. Questo prodotto non deve essere smaltito 
unitamente ad altri rifi uti commerciali.
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CORRETTO SMALTIMENTO DELLE BATTERIE DEL 
PRODOTTO
(Applicabile nei paesi dell’Unione Europea e in altri paesi europei con sistemi di 
conferimento differenziato delle batterie.)
Il marchio riportato sulla batteria o sulla sua 
documentazione o confezione indica che le batterie di 
questo prodotto non devono essere smaltite con altri rifi uti 
domestici al termine del ciclo di vita. Dove raffi gurati, 
i simboli chimici Hg, Cd o Pb indicano che la batteria 
contiene mercurio, cadmio o piombo in quantità superiori 
ai livelli di riferimento della direttiva UE 2006/66. Se le 
batterie non vengono smaltite correttamente, queste 
sostanze possono causare danni alla salute umana o 
all’ambiente.
Per proteggere le risorse naturali e favorire il riutilizzo dei materiali, separare le 
batterie dagli altri tipi di rifi uti e riciclarle utilizzando il sistema di conferimento 
gratuito previsto nella propria area di residenza.
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